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About this PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple topics from the help information or read the online help in
PDF format. Because this content was originally created to be viewed as online help in a web browser, some topics may not be formatted properly. Some interactive
topics may not be present in this PDF version. Those topics can be successfully printed from within the online help.
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Chapter 1: Introduction to Performance
Manager

HP PerformanceManager (PerformanceManager) is a web-based graphical analysis tool available
onWindows, HP-UX, Solaris, and Linux operating systems. PerformanceManager provides
preformatted graphs and reports that you can use to evaluate system performance, to analyze
usage trends andmake system performance comparisons. You can use PerformanceManager to
analyze historic and real-time performance data available from connected data sources. This
enable you take decisions while troubleshooting and help improve system performance.

HP PerformanceManager performs the following functions:

l It enables you to design your own graphs, to comparemetrics across various nodes and to
comparemultiple instances of a resource on the same node.

l It helps you visualize data from different data sources such as HP Performance Agent, HP
Operations Agent, HP Reporter, Real-TimeMeasurement (RTM) and HP SiteScope.

l It enables you to draw and design performance graphs and tables for analyzing usage trend and
correlation.

l It supports different output types such as XML, CSV, TSV and XLS.

l It enables you to perform administrative tasks such as restricted access through user logons.

l It provides you an Admin User Interface tomanage nodes, define andmanage customers and
users.

Add Performance Manager to the List of Trusted
Sites

Youmust enable JavaScript support in your browser by adding PerformanceManager to your list of
trusted sites. To add PerformanceManager to your list of trusted sites for Internet Explorer or
Mozilla Firefox browser perform the following tasks:

For Internet Explorer

1. On the Toolsmenu , click Internet Options. The Internet Options dialog box opens.

2. Click theSecurity tab. Click the Trusted Sites icon.

3. Click Sites. The Trusted Sites dialog box appears.

4. Enter the PerformanceManager web server URL, and click Add. The URL you entered
appears in the list of trusted sites.

5. Click Close.
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6. Click OK.

For Mozilla Firefox

1. On the Toolsmenu, click Options. TheOptions dialog box appears.

2. Click thePrivacy tab.

3. Click theExceptions button.

4. Enter the PerformanceManager web server URL in the box under Address of web site.

5. Click Allow.

6. Click Close.

7. Click OK.

8. Restart the browser.

Browser Settings
Before using HP PerformanceManager, you need to install Adobe Flash Player and configure
JavaScript support in your browser to be able to view the HP PerformanceManager home page.

You also need to configure your browser settings to display Microsoft Excel and TSV files.

Configure Browser Settings to Display Microsoft
Excel and TSV Files

Youmust check if the download option is enabled in the browser security settings. To check these
settings in the Internet Explorer browser perform the following tasks:

For Internet Explorer

1. On the Toolsmenu of Internet Explorer, click Internet Options. The Internet Options dialog
box appears.

2. Click theSecurity tab. Check if the security level in your browser settings is set to low.

3. Select the Internet icon, and click Custom Level. TheSecurity Settings pop up appears.

Note: If you are using PerformanceManager as Local Intranet application, select the Local
Intranet icon.
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4. Scroll down to the Downloads section and select theEnable option under File Download.

5. Click OK and close the Internet Options dialog box.

6. In Control Panel, click Folder Options.

7. Click the File Types tab to display the list of registered file types.

8. Select XLS from the Registered file types list. For TSV, select the TSV file format from the list
and click theAdvanced button. TheEdit File Type pop up appears.

9. Clear theConfirm Open After Download check box.

10. Click OK.

Note: If TSV is not added to the list of registered file types, you need to add it first and then
edit the file type settings.

Configure Support for JavaScript
If JavaScript is not enabled in your browser the HP PerformanceManager home page does not
appear. The browser displays amessage "JavaScript is not enabled in your browser. Enable
JavaScript to view this page".

To configure JavaScript support for your Internet Explorer or Mozilla Firefox browser perform the
following tasks:

For Internet Explorer

1. On the Toolsmenu of Internet Explorer, click Internet Options. The Internet Options dialog
boxappears.

2. Click theSecurity tab. Check if the security level in your browser settings is set to high.

3. Select the Internet icon, and click Custom Level. TheSecurity Settings pop up appears.

Note: If you are using PerformanceManager as Local Intranet application, select the Local
Intranet icon.

4. Scroll down to Scripting section and select theEnable option underActive Scripting.

5. Click OK.

6. Click Apply.
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For Mozilla Firefox

1. On the Toolsmenu, click Options.

2. Click Content (in Firefox version 3.5 and 3.6).

3. Select theEnable JavaScript check box.

4. Click OK.

Install Adobe Flash Player
If Adobe Flash Player is not installed on your browser, PerformanceManager Home page does not
appear. The browser displays amessage "Install Adobe Flash Player to view the Performance
Manager Home Page", you can click themessage to install Adobe Flash Player.
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Chapter 2: Getting Started with HP
Performance Manager

You do not require any user name or password to log on to PerformanceManager by default. If there
is no password assigned for the blank user logon, the home page appears on starting Performance
Manager. If you want to have a user name and password created, contact your Performance
Manager administrator. If your PerformanceManager is configured with Microsoft Active Directory
server, the home page will prompt you enter your user name and password to enable access to
PerformanceManager. For more information onMicrosoft Active Directory Configuration, seeHP
PerformanceManager Administrator Guide.

After you log on to HP PerformanceManager, the Home Page appears. The home page consists of
Standard View and Diagnostic View.

The HomePage displays helpful tips on using PerformanceManager under the Tip of the Day
section. If you do not want to view these tips, select the Don't Show Tips check box, and then click

.

The tip reappears if you launch the HomePage after clearing the history of your web browser. To
completely disable the Tip of the Day feature, set the SHOW_TIP_OF_THE_DAY variable in the
OVPMConfig.ini file to false. See thePerformanceManager Administrator Guide for more
information.

Note: You can configure the time period after which PerformanceManager browser session
expires. The default session time-out value is one hour.

Standard View
The Standard View shows the node list tree on the left and graph list on the right.

The nodes in the node tree are sorted alphabetically. Only nodes which are added to Performance
Manager and imported from Operations Manager are sorted alphabetically. The nodes imported
from Reporter, and SiteScope Server are not sorted alphabetically.

Note: If the PerformanceManager administrator makes any changes to a node group, the node
group appears collapsed. Expand the node group to view any new changes to the list of nodes
or groups.

From this page, you can perform the following tasks based on your profile:

l Search Nodes

l AddNodes Temporarily

l Import Nodes from HP Operations Manager, HP Reporter and HP SiteScope Server

HP PerformanceManager (9.20) Page 10 of 93



l Configure Instance Selection Option for Multi-Instance Class of Metrics

l ReloadGraphlist

l View Graphs

l Modify Default Date, Time and, Summarization Settings for Graphs

l View System Information

l Change Password

l Administer PerformanceManager if you are an Administrator

You can also perform the following graph related functions

l DrawingGraphs

l Designing Graphs

l Editing Graphs

l Editing Graphs (if user-defined)

l Managing Favorite Graphs

l Using the DesignWizard

Search Nodes

You can search for a node using the Search feature.

l Type the name of the node in the text box and click Search . You can also press ENTER to
search for the node.

l If the node you are searching for is available, the node is highlighted.

l If the node you are searching for is present within a node group, the node group expands and the
node is highlighted.

l You can search for a node by typing the first alphabet of the node name or you can also search
for a node by typing in any of the characters of the node name. The text you type in the text box
is not case- sensitive.

l If the node you are searching is not available, a message stating that the node is not found
appears. You can add the node entered in the text box directly to the node list tree by clicking the

Add a Node icon .

Note: In theManage Nodes option of theAdminmenu you cannot search for HP Operations
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Manager, HP Reporter, and HP SiteScope nodes. Only the respective node groups are visible.
However, you can search for PerformanceManager nodes and node groups.

Add Nodes Temporarily

To add a node temporarily:

1. Click Add Nodes icon . TheAdd a Nodewindow appears.

2. Type the name of the node which you want to add in the text box.

3. Click Add.

Alternatively, you can also add a node temporarily by entering the name of the node in the search

text box and clicking the icon. The newly added node is displayed at the bottom of the node list
and appears highlighted.

The PerformanceManager administrator can enable or disable the option to temporarily add nodes.
For more information, seeHP PerformanceManager Administrator Guide.

The PerformanceManager administrator can add and delete nodes permanently through the
Manage Nodes screen. In case you want to add and delete nodes permanently, contact your
PerformanceManager administrator.

Nodes added temporarily are not alphabetically sorted. Nodes added temporarily in the Standard
View page will not be displayed in the Diagnostic View, also any node added temporarily in the
Diagnostic View page will not be displayed in the Standard view.

You cannot upload or manage a flat file from the PerformanceManager user interface. A flat file is
essentially an ASCII text file with one record per line. Every field in the line is separated by a tab, or
a comma. A header line at the top of the file defines the contents of the file including the date, time
andmetric names. A flat file or business unit file will be treated as a node and has to be uploaded by
the PerformanceManager administrator to the PerformanceManager server. For more information,
refer to theHP PerformanceManager Administrator Guide.

A flat file has to be uploaded by the PerformanceManager administrator to the Performance
Manager server. After the flat file is uploaded, it appears on the node list tree under the node group
called "file".

Import Nodes

This option allows you to import nodes from HP Operations Manager forWindows, HP Reporter,
and Agentless Data source to PerformanceManager.

From HP Operations Manager

PerformanceManager imports the list of nodes configured in HP Operations Manager forWindows
when PerformanceManager starts. The following option can be used to import the node list anytime
after startup:

l Click Nodes -> Reload HPOM. PerformanceManager retrieves the nodelist from Operations
Manager and reloads the nodelist tree in theSelect Nodeswindow. Any new node added to
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Operations Manager is also listed on reload.

Note: This option is enabled only if PerformanceManager is configured to import the nodelist
from HP Operations Manager (HPOM). If you do not want to import nodes from HPOM, contact
your HP PerformanceManager administrator to disable this option.

From HP Reporter

PerformanceManager imports the list of nodes configured in HP Reporter when Performance
Manager starts. The following option can be used to import the node list anytime after startup:

l Click Nodes -> Reload Reporter. PerformanceManager retrieves the nodelist from Reporter
and reloads the nodelist tree in theSelect Nodeswindow. Any new node added to Reporter is
also listed on reload.

Note: This option is enabled only if PerformanceManager is configured to import nodelist from
Reporter. If you do not want to import nodes from Reporter, contact your HP Performance
Manager administrator to disable this option. However, you will still be able to use
REPORTER and REPSYS data sources to design and draw graphs.

From Agentless Datasource

PerformanceManager imports the list of nodes configured in HP SiteScope Server when
PerformanceManager starts. The following option can be used to import the node list anytime after
startup:

l Click Nodes -> Reload Agentless. PerformanceManager retrieves the nodelist from the
SiteScope Server and reloads the nodelist tree in theSelect Nodeswindow. Any new node added
to SiteScope Server is also listed on reload.

This option is enabled only when PerformanceManager is configured to import nodelist from
SiteScope Server. If you do not want to import nodes from Agentless Server, contact your HP
PerformanceManager administrator to disable this option.

You can import both host based nodes and non-host based nodes from Sitescope Server. Host
based nodes are directly listed under the nodegroup specified in the OVPMconfig.ini file. Examples
of Host based nodes are those that aremonitored by monitors like CPU monitor, File monitor,
Memory monitor, and so on. These have HOSTNAME as a key metric in Sitescope Server.

Sitescope Server also has non-host based nodes likeWeb Servicemonitor, URLmonitor,
LDAP monitor, and JMX monitor, and so on. The nodes monitored by thesemonitors are also
imported by PerformanceManager and they get grouped under the corresponding CLASSNAMES.
For example if you have configured PerformanceManager to import nodes from Sitescope Server
abc.xyz.com into the nodegroup 'DataCenter1', and if this Sitescope Server has a URLmonitor
which is monitoring 'url1' and 'url2', then the imported nodegroup will be displayed.

PDF version of Online Help
Chapter 2: Getting Started with HP PerformanceManager

HP PerformanceManager (9.20) Page 13 of 93



The nodegroup names for non-host basedmonitors are not configurable and are automatically set
based on the classname in which they get logged. These classes do not have HOSTNAME as a
key metric.

Configure Instance Selection option for multi-instance class of metrics

When you are usingmulti-instance class of metrics to draw or design a graph, you can enable or
disable the 'Instance Selection' option. The PerformanceManager administrator can configure the
default value.

If you want to select instances:

l Click Graph→ Instance Selection - Turn On. When you draw a graph with multi-instance
class of metrics, a prompt to select instances appears.

If you want to disable the instance selection option, do the following:

l Click Graph→ Instance Selection - Turn Off. When you draw a graph with multi-instance
class of metrics, all instances of themetric appears in one graph.

However the option you select is effective only for the current session and will be reset to the
default value the next time you logon.

Reload Graphlist

Use this option to view themost recent changes made to the graph list. You can view the changes
made by another user with the same login credentials in a different session. To reload graph list
click Graphs -> Reload Graphlist.

View Graphs

From themenu bar, click View -> Drawn Graphs. Any graphs which are drawn previously appear.

Multiple graphs appear as tabs in the samewindow.

Change Date Defaults

HP PerformanceManager uses the date settings specified in the template by default. For more
information, see Changing Default Settings.

When you are drawingmore than one graph, any changes to the default values which you have
specified will be retained while drawing another graph.  The values specified will not be reset.

View System Information

To view system information for a node, perform the following tasks:

l Select the system for which you want to view system information from the node tree. Click .

l The system information of the selected node appears in a new page. The system information
includes details such as: System ID, the Data source, Data communication protocol, Number of
disks and CPUs available, Operating system name, Operating system version, list of key
metrics and available metric classes and number of instances available for eachmetric class.

Change Password
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You can change your password once you log on to PerformanceManager. To change the
password, perform the following tasks:

1. From themenu bar, click Admin -> Change Password. The Change Password window
appears.

2. Enter the new password in theNew password text box.

3. Re-enter the new password in theConfirm Password text box again.

4. Click OK. A confirmationmessage which states that your password has been changed
successfully appears.

If you are a PerformanceManager administrator, you can perform the following tasks from the
Standard-view:

Note:

l Themaximum length for a password is 15 characters. The password can be a combination
of alphabets, numbers, and the special characters: !,@, #, $, ^, *, _.

l You need to enter the same password string in both the places to ensure that your password
change is successful.

l The Change Password option is not available when you log on to PerformanceManager
which is configured with theMicrosoft Active Directory server.

Administrator tasks

If you are a PerformanceManager administrator, you can perform the following tasks from the
Standard-view:

l "Manage Nodes" on page 62

l "Manage Users" on page 64

Drawing Graphs
You can draw graphs using a set of predefined templates or your own graph templates

l Select a node or a flat file for which you want to draw a graph from the node tree on the left pane.
You can also select multiple nodes to draw a graph. Flat files are categorized under the family
name "File".

Note:
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n Graphs are drawn in one or more tabs based on the type of graph.

n PerformanceManager supports the use of flat files or a business unit files to upload data
for analysis. A flat file or business unit file is treated as a node and has to be uploaded to
the PerformanceManager server. A flat file can be uploaded only by a Performance
Manager Administrator.

l Select a graph from the graph list in the right pane. You can also create your own graphs using
the Design wizard. PerformanceManager maintains a graph Family tree, which consists of
Family, Category andGraph Name. Graph Family refers to the group that organizes graphs and
Graph category refers to the various categories of graphs within the family. TheGraph Name
uniquely identifies a graph definition.

Note:

n You can alsomodify default settings for date, time, and summarization. If you want to
modify the default settings, see Change Date Defaults.

n When you are drawingmore than one graph, any changes to the default values which you
have specified will be retained when you draw more graphs until youmodify these
values.

n A graph template designed for a flat file, by default will include the details of the flat file
for which the graph template is designed. In case you want to select a different flat file,
make sure themetrics in the graph template is same as themetrics available in the new
flat file.

n There are SiteScopemetrics that are aligned with Performance Agent (PA)metrics.
Hence, if you are drawing an out-of -the-box graph against an Agentless node that
contains one or more of the alignedmetrics, the graph will be drawn only for those
metrics.

l Click Draw to get a graph with default properties. The graph appears in a new tab in the same
browser window.

Note:

n If you select a node without selecting a graph and click Draw, theGraph Selection pop-
up appears. Select a graph and click Draw. Click Cancel to close the pop-up.

n If you click Drawwithout selecting a graph and a node, the pop-up forNode Selection
appears. After you select a node, a pop-up forGraph Selection appears.

n If you select a Graph without selecting a node and click Draw, theNode Selection pop-
up appears. Select a node and click Draw. Click Cancel to close the pop-up.
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n If you are drawing a user-defined graph and if you have not selected a node while drawing
the graph, by default the node selected during design time is used in the graph. If you
select another node when you draw the graph, this selection will override the node
selected during design time.

l Click Back to Home at the bottom of the page orHome from themenu bar, to go to the home
page. To view the drawn graphs from home page, click View→Drawn Graphs.

l To view the data in tabular form, you can use drill down option. You can also use this option to
draw a different graph (image or table).

l To print a graph, click onGraphs→ Print. The graph appears with information in the print view.

l You can zoom-in to view a smaller set of data points and zoom-out to reset and view the original
graph.

l You can also export the graph to formats such as TSV, CSV, XLS, XML. Click Graphs→
Export. TheExport from a Graphwindow appears. From theExport type drop-down select
the required format. Click OK, the graph in the selected format appears in a new window.

l You can alsomodify a drawn graph. You can preview themodified graph and save it as a
different graph. Click Graphs → Edit. TheMetric Selection page in the DesignWizard appears.
You can edit the graph attributes. To go back to the graph, click View→Drawn Graphs.

l You can draw any number of graphs and each graph would be displayed in a different tab in the
same page. The first graph appears in a new window and the subsequent graphs appear in tabs
on the samewindow. You can also create a list of favorite graphs.

Note: If you have toomany graphs open on the screen, it might be difficult scroll and view all
graphs. To close all graphs, click Graphs→Close All Graphs.

Graph types

Select the graph style from the drop-down selection box:

Line - Draws eachmetric as a line. Line Styles andMarkers are only valid for this graph type.

Area - Also known as a filled line graph. This shows eachmetric as a line with data below the line
filled in the same color. Multiple metrics must have the same units.

Bar - Vertical bars for eachmetric.

Mixed - Eachmetric can be individually set as a line or area.

Horiz bar - Horizontal bars for eachmetric.

Pie - Circular pie chart.

Gauge - Displays a single automotive type dial gauge for eachmetric
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Table - Tabular display of the data with columns for eachmetric and each record displayed in its
own row.

Horiz table - Horizontal table with columns for each record and eachmetric displayed in its own
row.

Baseline - Shows the average values for a single metric for a "typical week." A baseline graph is
useful to identify patterns in system activities. All the available data from the data source is used to
generate this baseline and so it may take a few moments to produce. To calculate the baseline for a
typical day, PerformanceManager requires more than 7 days of data for the selected system.

When you draw a baseline graph, 8 graphs are drawn. The first graph in the series is a "typical
week" graph which displays the average values of a system, organized by day of the week, and by
hour of the day. Following this graph are 7 graphs displaying the expected high and low values for
themetric versus the actual metric value. The subsequent graphs display values for all the days of
the week. In the subsequent graphs, the blue line displays the range of the values that is
"Expected" at a particular hour of the day of the week. The expected values are determined by
examining all past data for the system and calculating statistics for every hour of every day of the
week. The blue lines typically display the range where 80 percent of the data points are expected to
fall. The red line displays the actual data for each hour of the day.

Note: Baseline graphs do not support the following features, which are supported by other
graph types:

l Mouse Hover - You cannot see the date and other information by hovering themouse on
the graph.

l Export - You cannot export the performance data to any format.

l Drill Down - You cannot drill-down graph to view the historic data for a selected period.

l Zoom in/ Zoom out - You cannot adjust the summarization levels in the graph for a
selected time-frame.

l Previous/ Next - You cannot view the data for adjacent time-frames.

XML - Returns the data in XML format.

Excel - Returns the data as an Excel spreadsheet. The client should haveMicrosoft Excel™
installed in order to properly view this graph type.

TSV - Returns the data as Tab Separated Values. This format is similar to CSV except that it
separates each item with the tab character instead of a comma. This format may be easier to
display since the tabs tend to visually align each column.

Note: If you are selecting aMicrosoft excel or a TSV graph, you need to configure the browser
settings to display Microsoft Excel and TSV files. For instructions, see Configuring browser
settings to display Microsoft Excel and TSV files.

CSV - Returns the data as CommaSeparated Values (The values are separated by commas) This
is a generic way of representing data that is importable into a variety of other products.
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Drawn Graphs

From the home page, click View→Drawn Graphs, the graph appears in one or more tabs.

l On this page, PerformanceManager provides the following navigation options:
n PerformanceManager provides Prev andNext buttons based on the value specified for

"points every" while drawing a graph.

n PerformanceManager provides Append andPrepend buttons based on the value specified
for "points every" while drawing a graph.

l To view the data in tabular form, you can use Drill down option. You can also use this option to
draw different graph (image or table).

l You can add the graph as a favorite graph .

l To view themost recent changes, select the checkbox Automatically Refresh. Themost recent
data from data sources is displayed.

l To print a graph, click onGraphs→ Print. The graph appears with information in the print view.

l You can zoom-in to get a narrow down the view to a smaller set of data points and zoom-out to
reset and view the original graph to narrow down to one set of data.

l You can also view the exact value of the data when you hover themouse over the points on the
graph a pop-up displaying the actual value of the data point and time stamp appears. If the graph
type is line, the pop-up also displays the line color of the selected data point andmetric name.
However you can turn-on or turn-off themouse hover option as required. To turn off this option,
click Graphs→Mouse Hover-Turn Off. But this setting is effective only in the current session
and is reset to the default option in the next session. To turn on this option, click Graphs→
Mouse Hover-Turn On. The PerformanceManager administrator can configure the default.

l You can also Hide or Show metrics after the graph is drawn to view only the required set of
metrics without editing the graph.

l You can use the Y-axis scroll bar available beside the Y-axis to adjust the scale range.

l You can also export the graph to formats such as TSV, CSV, XLS, and XML. Click Graphs→
Export. TheExport from a Graphwindow appears. From theExport type drop-down select
the required format. Click OK. The graph in the selected format will appear in a new page. For
the details graphs that present data in the tabular format across multiple pages, you can select
the All Data checkbox to export records from all pages.

l You can alsomodify a graph. Click Graphs→ Edit. TheMetric Selection page in the Design
Wizard appears. You can edit the graph attributes. To go back to the graph, click View -> Drawn
Graphs.

If Performance Agent, version 5.00 is installed on the node, older versions of user-defined graph
templates containing Virtualizationmetrics or metrics from the 'Logical system' class created
using older version of PerformanceManager, will work if youmanually update the graph templates
by replacing the label BYLS_LS_ID and BYLS_LS_NAME with BYLS_DISPLAY_NAME.
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If you are launching a VIRTUALIZATIONGRAPH using a graph template
“VIRTUALIZATIONGRAPH “ containing logical system class of metrics for an instanceGuest1,
which is configured with Resourcepool1 and installed on Host1, then the format of the path will be
as below:
http://<servername>:8081/OVPM?SYSTEMNAME=ConfiguredVIMANODE&GRAPHTEMP
LATE=VIRTUALIZATIONGRAPH&GRAPH=VIRTUALIZATIONGRAPH
&INSTANCE=Host1/Resourcepool1/Guest1

DrillDown

You can use theDrillDown option to view the data displayed on a graph in tabular form. You can
also use this option to draw different graph (image or table) with more granularity:

a. Click DrillDown option on theGraphsmenu. TheDrillDown pop-up appears.

By default, the start Date and end Date of the table graph after drill down is same as the
start date and end date of the original graph. To view more granular data, perform the
following steps:

i. UnderStart Date, drag the indicator to specify a start date and time.

ii. UnderEnd Date, drag the indicator to specify an end date and time.

iii. Select one of the following options from theDrill To radio buttons.

i. Graph - Select this option if you want to drill down to a specific time-interval andmore
granular data in the graph format.

ii. Table - Select this option if you want to view records in tabular format. The graph type
will be changed to table format. You can also filter or highlight the data in tabular form.

iii. Process Table - Select this option if you want to view the process details on the
selected node.

iv. Draw a Different Graph - Select this option if you want to draw a different graph to
compare with the current graph. The graph list appears. Select a graph. This option is
disabled if you select drill down toProcess Table.

v. Click Draw. The data you requested appears in the format you specified while drilling down.

Note: The DrillDown option is available only for image graphs. This option is not available for
non-image graphs such as table, XML, excel.

Table Highlights

If you have chosen to view the data in the tabular format, you can highlight a cell based on its
content and set conditions to highlight the contents based on themetric value, so that the records
can be accessed easily.

To highlight a cell in the drill-down table,
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a. On theGraphsmenu, click Add Highlights. The Table Highlights pop-up appears.

b. The Table Highlightswindow displays the following options:

o Themetrics list displays all themetrics of themetric class. By default, the first metric of the
drill-down table is displayed.

o The comparison symbol list displays the comparison symbols to set the condition to the
filter. By default, = sign is displayed.

o The text box allows you to type a value to compare against themetric.

o Click Add to list the given condition below.

o If you want to edit the condition you have just added, make changes and click Update.

o Selected color displays the cell color you chose.

o Click Color to pick any color of your choice which will be used to highlight the table cells of
matching conditions.

o If you want to remove a condition from the list, select the condition and click Remove.

o Click Remove All to remove all the conditions appearing in the list.

o Click OK to filter the data based on the conditions specified in the list.

o Click Cancel to close the Table Highlights window.

o Click Help to display the context-sensitive help topics.

c. Select themetric which you want to highlight based on a condition.

d. Select a comparison symbol. Enter a value to compare against themetric.

e. Click Color, to add a color to the cell. The color picker pop-up appears. Select a color, from
the color palette and click OK.

f. Click OK.

Auto Refresh

When you select theAutomatically Refresh check box, the graph is redrawn approximately
every fiveminutes with the latest data available from the data source. Use this feature to refresh
the graph with recent changes from the data source.

The updates in the graph are obvious unless the Points Every value is set to small intervals, such
as every fiveminutes. The last point on the graph is re-calculated and re-averaged with the new
data. Any new point will not be plotted until it has reached the next interval. For example, if the
Points Every is set to 1 hour, a new point will not be plotted until it is 1 hour past the last point on
the graph.
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Note: The Automatically Refresh option is not available for forecast graphs.

Print View

To print a graph, do the following:

a. Click Graphs -> Print. The graph appears in a new window. This window displays the graph
with a complete description of graph data. In addition, thePrint dialog box appears with the
default options pre-selected.

b. Click Print to print the graph with the graph information.

Zoom-in and Zoom-out

After you draw a graph you can zoom-in to view a smaller set of data points and zoom-out to reset
and view the original graph:

a. To zoom-in data, click and drag themouse to a rectangular area on the graph from left to right.
The selected area is expanded. The zoom-in time frame appears below the graph image.

b. To zoom-out data, click and drag a rectangular area on the graph from right to left. When you
zoom-out a graph, the graph is reset to its previous state.

You can zoom-in data up tomultiple levels. Every zoom-out will take the graph to its previous
state.

Note: This option is available only for image graphs. However this option is not available for
image graphs such as pie, gauge, and forecast.

Hide or Show metrics

After you draw a graph, you can hidemetrics and view only a required set of metrics without
editing the graph. To hide or show metrics, perform the following tasks:

a. After you draw, click Hide/Show Metrics. The Hide or Show Metrics pop-up window
appears. The pop-up displays a list of metrics available in the graph with a check-box against
eachmetric. By default all themetrics available in the graph are pre-selected.

b. Tomodify themetrics appearing on the graph, select only thosemetrics which you want to
appear on the graph and unselect thosemetrics which you do not want in the graph. Use
Select All checkbox if you want to select all themetrics. If you want to clear the selection,
use theClear All checkbox.

c. If you want to view the graph with selectedmetrics without closing theHide or Show Metrics
pop-up, Click Apply. The graph is now redrawnwith only thosemetrics which you have
selected. However the window remains open till you click OK. You can continue tomodify the
metric selection.
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d. Click OK after you have selected themetrics which you want to appear in the graph. The
graph is redrawnwith themetrics which you have selected and theHide or Show Metrics
pop-up is closed.

e. Click Cancel to close theHide or Show Metrics pop-up without making any changes.

Note: The option to hide or show metrics is not available for graph types: table, pie, bar,
gauge, horizontal bar graph, htable, xml, csv, tsv, excel, baseline and forecast.

Y-axis scrolling

Use the Y-axis scroll bar available beside the Y-axis to adjust the scale range. For example, if you
want to view CPU utilization between 0 to 50% range, you can set the scroll bar to display the
data within that range.

To view data for a specific range, set the vertical scale on Y-axis by moving the slider up to
increase themaximum value on the scale and by moving it down to decrease the upper limit. The
minimum value that you can set on Y-axis is 1 and you can scale the slider up to 1 billion. When
the upper limit is set to 1000 or 10000 or 1million, PerformanceManager redraws the graph to
display the required data.

The graphs with the right Y-axis also provide you with the option to set the vertical scale. Use the
slider on the right Y-axis scroll bar to increase or reduce the upper limit.

Delete Graphs
You can delete only user-defined graphs. Follow these steps:

1. From themenu, select Graphs→Delete a Graph. TheGraph Selectionwindow appears.
This window displays a list of user defined graphs.

2. Select the graph which you want to delete and Click Delete. A message asking you to confirm
deletion appears.

3. Click OK. A message confirming the deletion appears.

4. Click OK.

Note:

l You cannot delete out-of-the-box graphs.

l You can delete graphs which you created or which are created using your credentials.

Using the Design Wizard
Using the design wizard you can do the following:
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l "Designing Graphs" below

l "Editing Graphs" on page 51

If you are designing a new graph, the design wizard displays "DesignWizard - New Graph" in the
title of the design wizard pages.

Designing Graphs

You can design a graph and save this as a template.

1. From themenu, click View→Design wizard or click Graphs→Design a Graph. The
Design Wizardwindow appears.

2. Select Design a New Graph and click Next. The following options appear in theDesign
Wizard - New Graph page:

n Designing a Normal Graph: Select this option to draw a normal graph. A normal graph
consists of metrics from only one data source. Themetrics can belong tomultiple classes.

n Designing a System Comparison Graph: Select this option to draw a system comparison
graph. A system comparison graph can be used to compare data frommultiple nodes. You
can select one or more nodes but you can select only onemetric. While designing a system
comparison graph, you can select only thosemetrics which do not havemultiple instances.
You can compare onemetric across multiple systems. At the time of design you can select
only one node. When you preview graphs, you can select more nodes.

n Designing a Instance Comparison Graph: Select this option to draw an instance comparison
graph. An instance comparison graph can be used to compare two or more instances of a
metric from a single data source from a node. You can select at least two instances for
comparison. You can select only onemetric. You can comparemultiple instances of a
metric on the same node. When you preview a graph while designing, from the design
wizard or draw from the display page, you can select one or more instances.

n Designing aMulti-source Graph: Select this option to draw amulti-source graph. A Multi-
source graph can be used to comparemultiple nodes with multiple metrics. Themetrics can
belong tomultiple classes. You can select multiple data sources. After you select a node,
you can select metrics frommultiple data sources available on the selected node. In case
you have selectedmulti-instancemetrics, you can also specify the instance.

n Designing a Forecast Graph: Select this option to draw a forecast graph. A forecast graph
can be used for Capacity Planning. PerformanceManager allows you to design forecast
graphs. PerformanceManager uses time-series based statistical forecasting techniques to
predict the service demands of users.

3. Select the type of the graph you want to design and click Next. Based on the type of graph you
select, the design wizard takes you through the steps to design a graph.

Capacity Planning
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The objective of computer capacity planning is to provide an acceptable, cost-effective level of IT
services to users while responding to workload demands generated by business requirements.
Capacity planning is an important part of managing an adaptive enterprise. Capacity planning
begins with collecting performance data.

The key to effective capacity planning is to understand the relationship between business
requirements, systems, network workload, IT infrastructure capacity, and the level of service
required by users. Changes in the business environment often result in changes in systems and
network workload. Planning for capacity changes can help you anticipate problems and suggest
capacity adjustments with greater confidence.

Node Selection

A window displaying a list of Nodes and flat files appears. If the PerformanceManager
administrator makes any changes to the node group, the node group appears collapsed in other
pages like home page, design wizard etc. Expand the node group to view any new changes to the
list of nodes or node-groups.

If you want to design a graph using a flat file as a data source, youmust make sure that the file is
uploaded to the PerformanceManager server. A flat file can be uploaded only by a Performance
Manager administrator. For more information, seeHP PerformanceManager Administrator Guide.
Select the node or flat file for which you want to design the graph. Flat files are categorized under
the family name "File".

While designing aNormal Graph, if you do not select any node and if Reporter is configured on
your system, by default Reporterwill be selected. For more information, refer to theHP
PerformanceManager Administrator's Guide.

If you want to design a graph using Agentless data source, youmust make sure that the Agentless
Server is configured on your system. An Agentless Server can be configured only by a Performance
Manager administrator. For more information, seeHP PerformanceManager Administrator Guide.

To design graphs you need to select metrics from the data sources found on the nodes. The node
you select will be saved in the graph template.

If you are editing a pre-defined graph, the nodes selected while designing that graph will be pre-
selected. You canmodify this and select nodes for which you want to draw the graph. The name of
the graph which you are currently editing appears in the title of the design wizard page. The node
will remain pre-selected only if the node is still available under the same node group path. If the
node has beenmoved to a different node group, then the node will not appear pre-selected.

When you preview the graph, by default the data from the node you selected during design time will
be used.

l You can search for a node using the Search feature. Enter the name of the node in the text box
and click on the icon .

l You can view the system information of a node by clicking .
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l To clear your selection click .

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.

l You can also add a node temporarily. Click , theAdd a Nodewindow appears. Enter the
name of the node which you want to add. Click OK. However you cannot upload or manage a
flat file from the PerformanceManager user interface. A flat file or business unit file will be
treated as a node and has to be uploaded to the PerformanceManager server. A flat file can be
uploaded only by a PerformanceManager Administrator.

Note: For all graph types other thanMulti-source graphs, you can select only one node while
designing.

Data Source Selection

When you select a node in the previous step, PerformanceManager fetches the list of data sources
available on the node. Data sources are the agents which collect performance data. If you have
selected a flat file in the previous steps, by default the option FILE appears pre-selected.

If you are editing a graph, the name of the graph which you are currently editing appears in the title
of the design wizard page.

l If you have selected a node in the previous step, PerformanceManager displays a list of data
sources available on the node.

l Select a data source from the list of data sources. Each data source collects a set of metrics to
capture performance data, based on which you can draw graphs for analysis. You need to
specify metrics to draw or design graphs.

l A node can have one or more data sources. For example, HP Performance Agent (PA),
Embedded Performance Component (EPC), Repsys (nodes from HP Reporter), Business unit
file (flat file), and Agentless (SiteScope).

Note:

n The Agentless option appear only if the selected nodemonitored by SiteScope Server is
configured in PerformanceManager.

n To view the list of metrics and the definitions for Performance Agent and EPC, refer to
the HP Performance Agent's "Dictionary of PerformanceMetrics".

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.
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To configure a particular data source, contact your PerformanceManager administrator. Data
sources on the node/nodes you selected, are discovered at runtime by PerformanceManager. So,
you do not have to know beforehand the data sources available on a particular node.

If you are designing a system comparison graph, you can select only one node on this page.

You can configure the time period after which PerformanceManager connection times out when
connection to agents through http(s) is not successful in the Server. Modify this parameter to an
optimal value to enable quicker time outs when the agent is not reachable.

You can configure the rate at which PerformanceManager refreshes metadata from the data
sources. You canmodify it to an optimal value, to improve the time taken to generate graphs.

Graph Attributes

If you are editing a graph, the fields specified below are populated with the values specified in the
graph template. However you canmodify these values. The name of the graph which you are
currently editing appears in the title of the design wizard page.

l Title: Enter a title for the graph. This graph title is displayed on the top of the graph. You can use
any of the substitution variables for graph title; however, the actual values replace the variables
after a graph is designed or drawn.

l Subtitle: Enter a subtitle for the graph. This subtitle is displayed below the title. You can use any
of the substitution variables for Graph Subtitle; however, the actual values replace these
variables after a graph is designed or drawn.

Example: If you are designing a graph titled "Global History" for a node 'mysys.xyz.com', for a
duration of 7 days ending on 4/11/2007, 11.00 AM for Points Every one hour, the following details
are displayed:

l Graph Title - Global History for mysys.xyz.com

l Subtitle - 1 week, at points every hour

l Time displayed beneath the graph - From 4/4/07 11.00 AM to 4/11/2007 11.00 AM

l Graph Type: Select the type of graph you want to design from the drop-down list. For a forecast
graph, by default the graph type is line graph. Hence this option is disabled while designing a
forecast graph.

l Limit Number of Points: Enter the number of records (table graph) or data points (for image
graph) which you want to view on the graph at a time. The default value is 100. If the graph
contains more data points, thePrev andNext buttons are enabled, so that you can navigate to
view all the data points. The number of points also depends on the graph type which you have
selected.

n For a table graph, the default value for number of rows can be configured by the
PerformanceManager administrator. For more information, see theHP Performance
Manager Administrator Guide. However the value specified while designing a graph
template overrides the default value and the value is saved in the graph template.

o The recommended value for maximum number of points is 1000 for a graph. If
you select a value greater than this for table graphs, the processing time is very
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high.

n If you are designing a pie graph or a gauge graph, by default, the Limit Number of Points
is set to 1. You cannot change this value.

n If you are designing a baseline graph, you cannot change the value for Limit Number of
Points.

l Description: Enter a general description of what the graph represents. The description entered
here appears as tooltip when themouse is hovered over the graph name in the graph list tree.
The graph list tree is displayed when PerformanceManager prompts you to select a graph or
when you are viewing the home page.

l Automatically Refresh: When you select the Automatically Refresh check box, the graph is
redrawn every fiveminutes with the latest data available from the data source. The refresh rate
is configurable. Contact your PerformanceManager administrator to configure the time interval
for refreshing data. For more information, refer to theHP PerformanceManager Administrator
Guide.

l Sum From Raw: Select this option if you want to specify that PerformanceManager should
gather unsummarized data from the data sources and then summarize the retrieved data. Select
this option when you do not want the data to be summarized by data source. Using this feature
can cause large volumes of data to be transferred from the node and can slow down the resulting
graph. When you select this option, you can specify the summarization level for individual
metrics.

l Force Points Every: Select this field to force control on the granularity (number of points) on
the graph. Selecting this value overrides any Points Every value that the specified while
drawing a graph.

l Date Range: The default date range is 7 days ending 'Now' and Points Every value is auto
summarization. You can alsomodify default settings for date and time. If you want to modify the
default settings refer to the section, Changing Default Date Settings.

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.

Note:

l The date selection specified here is saved in the graph template. These settings are used
you preview and draw graphs.

l If you are drawing a forecast graph, you can specify the forecasting date range in this
screen or on the planner screen of the design wizard too.

l You cannot specify Graph type, Limit number of points and Automatically refresh options if
you are designing a forecast graph.
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Changing Default Settings

You can override the default date range and shifts for a graph.

Change Date Defaults

HP PerformanceManager uses the date settings specified in the template by default. If date
settings are not specified in the graph template, then PerformanceManager uses the default date
range is: 7 days ending 'Now' and Points Every value: auto summarization.

Note: If you are using planner to draw forecast graphs, when you specify the forecasting date
range or planner, the forecast range would be same as the period selected for forecasting. For
example: if you select 1month, 1month's data would be used and the forecast is done for the
next 1month.

To specify date range for a graph:

1. ClearUse Defaults checkbox.

2. Specify the time duration for which you want to draw the graph in theDuration text box.

3. Enter the number and specify the unit of time. You can specify time duration in minutes, hours,
days, and weeks.
If you select "all", all the data gathered by the data source and logged in the agent log files is
included in the graph and the text entered in theDuration text box is not considered.

4. Specify the end date for the graph. The default value is 'Now'. Select from one of the following
options:

l Now - the current date and time on the HP PerformanceManager Server.

l Last - the date and time when data was last collected by the data source.

l Date/Time - When you select this option, the calendar icon is enabled. Click the calendar icon
to select the date. Select the time from the Time drop-down list.

Example: If you select "4 weeks" of data ending Now, the graph displays data for the last 4
weeks. If you select "3 days" of data ending at January 12, 2007 at 13:00 hours, you can
view the data from 'January 9, 2007 at 13.00 hours' to January 12, 2007 at 13.00 hours'.

5. Use thePoints Every setting to control how much data is to be summarized in each point on
the graph. You can use the Points Every option to determine the granularity (number of data
points) on the graph. The default value is Auto. You can select from the following options:

Note: If you are using flat file or a business unit file as a data source to design a normal
graph, make sure you specify the points every value based on the data available in the flat
file or business unit file.
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Auto Selecting this option automatically selects the value to
display the data points within the configured limit. If you
select "auto", PerformanceManager will automatically
summarize the data based on the date range that you have
specified to a level that wouldmake the graph easy to
read. If the combination of Date Range and Points Every
settings results in toomany points, the Points Every value
is automatically adjusted to display all of the requested
data in one page.

In addition, PerformanceManager also provides Append
and Prepend options to increase the data points which
you can view on a single page.

n Click Append >> button to view data for the next set of
data points, in addition to the data you are currently
viewing.

n Click Prepend << button to view data for the previous
set of data points, in addition to the data you are currently
viewing.

If you click Append or Prepend button, Performance
Manager adds additional data. The number of points
displayed is same as the data points which appear in the
initial graph. The duration is doubled. For example, if you
were currently viewing data for the previous 1month, and
you click prepend, you can view data for the previous 2
months.

All the data points are displayed in the same page. The
points every setting is reset by PerformanceManager to
make the data readable. When all the data available is
displayed, theAppend and Prepend buttons are
disabled.

Example 1:When the combination of the date range and
Points Every settings is one week of data from 1/1/2007
to 8/1/2007 with points every one hour, if you Click
Append/Prepend additional one week of data is
displayed in the same page. You can see two weeks of
data with points every three hours.

Example 2: For example, if you have specified the
Duration as 12 hours, the graph displays this data for 12
hours and the summarization is automatically set by
PerformanceManager to accommodate this data within
one page.

PDF version of Online Help
Chapter 2: Getting Started with HP PerformanceManager

HP PerformanceManager (9.20) Page 30 of 93



Note:Based on the value set for limit number of points,
for image graphs, summarization interval is decided by
PerformanceManager when 'points every' is selected as
auto. The behavior of theNext/Prev button is different if
'points every' is selected as "auto", unlike the behavior
when points every is specified as any other value other
that 'auto' from the drop down. When auto is selected,
user gets data for the duration specified, in the same
graph, with summarization interval specified by
PerformanceManager. TheNext/Prev options displays
the graph from the next and previous duration with the
same points every (summarization) value.

5 minutes Selecting this option displays one data point for every five
minutes of the specified duration.

15 minutes Selecting this option displays one data point for every
fifteenminutes of the specified duration.

30 minutes Selecting this option displays one data point for every
thirty minutes of the specified duration.

hour Selecting this option displays one data point for every one
hour of the specified duration.

3 hours Selecting this option displays one data point for every
three hours of the specified duration.

6 hours Selecting this option displays one data point for every six
hours of the specified duration.

12 hours Selecting this option displays one data point for every
twelve hours of the specified duration.

day Selecting this option displays one data point for every day
of the specified duration.

unsummarized If you select "unsummarized", PerformanceManager
does not summarize the data. The raw data collected by
the data source for the specified duration is displayed. Any
values set in PerformanceManager does not affect the
summarization.

If the points every value is anything other than "auto", and if the data in the chosen time range
cannot be fit into a single graph/table, the graph/table appears in more than one page andPrev
andNext buttons are enabled. Click Prev to move to the previous page andNext to go to the
next page to view all the data. TheAppend/Prepend options are disabled when you set Points
Every to anything other than auto.
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6. Enter the number of records (table graph) or data points (for image graph) which you want to
view on the graph at a time in Limit number of Points. The default value is 100. If the graph
contains more data points, thePrev andNext buttons are enabled, so that you can navigate to
view all the data points. The number of points also depends on the graph type which you have
selected.
n For a table graph, the default value for number of rows can be configured by the

PerformanceManager administrator. For more information, see theHP Performance
Manager Administrator Guide. However the value specified while designing a graph
template overrides the default value and the value is saved in the graph template.
o The recommended value for maximum number of points is 1000 for a graph. If you select

a value greater than this for table graphs, the processing time is very high.

n If you are designing a pie graph or a gauge graph, by default, the Limit number of Points is
set to 1. You cannot change this value.

n If you are designing a baseline graph, you cannot change the value for Limit number of
Points.

When you are drawingmore than one graph, any changes to the default values which you have
specified will be retained while drawing another graph.  The values specified will not be reset

You can use any of the substitution variables for Graph Title or Subtitle; however, actual values will
replace these variables after a graph is designed or drawn.

@@[SYSTEM] Refers to the name of the system being graphed.

@@DATERANGE Refers to the duration for which the graph is designed, (for example, 7
Days.)

@@POINTSEVERY Refers to the amount of time summarized into each data point, (for
example, points every 15 minutes).

@@STARTTIME Refers to the beginning time on the graph (for example 3/30/07 3:00
PM).

@@STOPTIME Refers to end time being displayed on the graph (for example, 4/10/07
3:00 PM).

@@metric The value of the metric.

For example: If you use @@APP_NAME, the title or sub-title will include
the value of the metric, that is name of the application.

Note: It is recommended that you use this parameter only when
single instance of a metric is drawn in a graph. If there are multiple
instances in a single graph, then all the instance names will be
appended to the title or sub-title.

Add Metrics
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1. Click Add Metrics. TheMetric Selectionwindow appears.

2. If you are designing amulti-source graph, theMetric Selectionwindow displays a list of data
sources available on the node or nodes you selected. From theData Sources drop-down,
select the node and data source combination which you want.

3. Expand themetric class name. If it is a flat file, themetric class name is FILEDATA. The list of
metrics appears.

4. Select one or moremetrics for which you want to draw graph and click Add.

5. Depending on the type of graph you are designing, follow these steps:

n If you are designing a system comparison graph or an Instance comparison graph, you can
add only onemetric. To change themetric you selected, Click Change Metric.

n If you are editing a graph, themetrics saved in the graph template is preselected. You can
remove ametric in case you want to modify this list.

n If you are drawing a forecast graph, refer to the section Suggested Forecast Metrics, for a
list of valid metrics for forecasting.

n If you are drawing amulti-source graph, you can select metrics frommultiple data sources.
Repeat steps a and b, after you follow step [1] to select different nodes and data source
combinations.

6. Click Close after you complete the selection. The list of metrics which you selected now
appears in a tabular form.

7. Remove ametric

a. From the list of metrics, select themetric which you want to remove by clicking on the row
corresponding to themetric.
Tip: Press and hold CTRL key to select and then removemultiple metrics.

b. Click Remove. The selectedmetrics are removed from the list.

8. Remove all metrics

a. Click Remove All. All themetrics will be removed from the list.

9. Specify the order of metrics

a. From the list of metrics, select themetric which you want to move up or move down by
clicking on the row corresponding to themetric.

b. Click Move Up to move themetric to the top of the list orMove Down to move themetric
to the bottom of the list from its current position in the list.
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Note: This option will be enabled only when there are two or moremetrics in the list of metrics.
This option is not available for instance comparison and system comparison graphs.

Suggested Forecast Metrics

The selection of metrics to forecast must reflect the specific needs of the environment. For
example, forecasting values for CPU Utilization, Response Time, and I/O Rate can often be useful
to maintaining an acceptable level of performance. The performance of particular applications may
also be important to maintain. If you are just getting started in forecasting, here are some suggested
metrics from HP Performance Agent, HP Reporter and HP OperationManager which you can use
in designing a forecast:

Class Metric Description

GLOBAL GBL_CPU_
TOTAL_UTIL

The amount of the CPU resource that is being consumed
on the system. When CPU utilization nears 100%,
processing slows down and responsiveness might
degrade.

GBL_DISK_
PHYS_IO_
RATE

The number of transfers made to and from all disk drives.

GBL_DISK_
UTIL_PEAK

The percent busy of the busiest disk drive. (Which disk
drivemay change).

GBL_DISK_
VM_IO_RATE

The number of transfers to and from disk in support of
memory management (swapping).

GBL_FS_
SPACE_UTIL_
PEAK

The perfect full of themost full file system.

GBL_NET_
PACKET_
RATE

The number of packets of information sent and received
from network links.

GBL_NUM_
USER

The number of users logged in to the system. (This might
make a useful business metric).

APPLICATION APP_CPU_
TOTAL_UTIL

The amount of CPU consumed by this application.

APP_IO_
BYTE_RATE

The amount of data transferred to and from disk devices.

APP_ACTIVE_
PROC

The average number of processes in the application that
were running during the interval.
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APP_
COMPLETED_
PROC

The number of processes that were run and terminated
during the interval.

TRANSACTION TT_TRAN_1_
HR_RATE

The number of transactions that completed each hour.

TT_WALL_
TIME_PER_
TRAN

The average time it took for each transaction to complete.

TT_SLO_
PERCENT

The percent of the completed transactions that exceeded
their pre-defined Service Level Objectives.

Note: The Application and Transaction class of metrics listed here aremulti-instance classes.

Metric Properties

You can configure the way a particular metric appears in the graph. To change the properties of a
metric, perform the following tasks:

l Label: The label can be a literal string, or it can contain references to special substitution
variables.

@@[LABEL] The metric label. For
example, CPU%. It refers
to the metric label
specified by the data
source. If the data source
does not provide a label
for the metric instance,
the metric name is used.

@@[METRIC] The metric name. For
example, GBL_CPU_
TOTAL_UTIL. By default
the metric name is
displayed on the graph or
table.

@@[CLASS] The metric class name.
For example, GLOBAL.

@@[SYSTEM] The node name
supplying the metric. For
example, mysys.net.com
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@@[DATASOURCE] The datasource of the
metric, for example,
CODA, PA, EPC,
REPSYS, and
AGENTLESS.

The metric label specified
by the datasource. For
example, (CPU %), if the
data source does not
provide a label, then the
metric name is used.

@@metric The value of the metric
from the same data
source and class.

For example:
@@BYDSK_DEVNAME
will label the metric with
the value of the BYDSK_
DEVNAME metric. If the
BYDSK_DEVNAME
metric value were "0",
Disk @@BYDSK_
DEVNAME would
produce a label of Disk 0.

For example, @@[SYSTEM]:@@[CLASS]:@@[METRIC] might produce a label like
"mysys.net.com:GLOBAL:GBL_CPU_TOTAL_UTIL".

l Type: Displays the type of graph which you selected while specifying graph attributes. If you
have selectedmixed graph, you can specify the graph type for themetric which you selected.
The options available are line or area.

l Y Axis: Specify whether you want the Y-Axis of the graph to appear on the left hand side or right
hand side from the drop-down list.

Note: This option is available only for graph types 'line', 'area' and 'mixed'. For all other
graph types, the option 'right' does not appear in the drop-down.

l Color: To specify a color for themetric, click Color. The color picker pop-up appears.

l Graph specific properties: Based on the type of the graph you select, you can specify
properties.

l Summarization: If you have selected the Sum from Raw check box on theGraph Attributes
page, the Summarization box appears, The default value is Average. Summarization of data is
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done whenmultiple records from a datasource are combined to view the required amount of time
per data point.

l Click OK to save your settings orCancel to exit from the window.

l Filter: A metric filter consists of ametric name, a comparison symbol and a value to compare.
You can add, update and remove filters.

Filter will be applied before summarization if PerformanceManager is summarizing the data. If the
data source is summarizing the data, the filter will be applied after summarization.

PerformanceManager does not support the "=@" filter. The "=@" filter in the OVPM 6.x is used in
case of textual metrics. The "=@" filter gathers all values from the data source, but separates each
distinct value into a separatemetric. In PerformanceManager 8.x, specifying the@@[Metric
Name] within the label gathers all the values from the data source and identifies each distinct value
as a separatemetric.

For multi-instancemetrics, PerformanceManager attaches a prefix @@[instancemetric] to the
metric label automatically while designing a graph using design wizard.

While specifying strings or expressions for filters, use regular expressions. (Example: .*C.* instead
of *C*).

To see the differences between filter options in OVPM 6.x and PerformanceManager 8.x, see the
HP PerformanceManager Administrator Guide.

For metric properties for area graphs or bar graphs, select the fill style from the drop-down list.

Line Style

1. Style - Select the line style for the lines in the graph from the drop-down list

2. Marker - Select amarker from the drop-down list

Note: If you specify amarker, you can differentiate if the data points displays missing data or
actual data. If data is missing for a particular interval, PerformanceManager connects both the
previous and the next data point with a straight line and themarker for that point does not
appear.

3. Width - Specify the width for the lines

Missing Data

When no data is captured by the data sources during an interval, it is referred to as missing data.
Select an option to represent missing data. Select from the following options:

o Hidden - Select this option to represent missing data as gaps in the graph.

o Zero - Select this option to represent missing data with the same value as that of the
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previous point.

o Previous - Select this option to represent the value of Missing data points as 'zero'.

Warning:When you set theMissing data value to 'Hidden', the single data points that do not
have a data point preceding or following them will not be visible. (It takes at least two points to
draw a line). To solve this problem, select markers for eachmetric. Markers will make the data
points visible even if a line cannot be drawn.

Data sourcemight not capture data in scenarios such as the following:

l No data found in a particular interval

l Data source is configured not to fetch data frequently.

Summarization

Summarization of data is done whenmultiple records from a data source are combined to view the
required amount of time per data point. The Summarization type option is available on theMetric
Selection screen of design wizard, only if you have the "Sum From Raw" check box selected on the
Graph Attributes screen. The various types of summarization options are as follows:

1. Auto - When you design graph with auto summarized data, PerformanceManager summarizes
data based on the summation type provided by the data sources, if theSum from Raw check
box on theGraph Attributes screen is not selected. If the summarization type is not provided by
the agents or if theSum from Raw check box on theGraph Attributes screen is selected and if
you specify the summarization type as 'auto', PerformanceManager uses the 'average' value
to summarize data. Currently, data sources such as Performance Agent and EPC provide
summarization types for the respectivemetrics.

2. Average - If the summarization type is not provided by the data sources and if theSum from
Raw check box is selected, by default PerformanceManager used the option 'average'. The
'average' refers to themean value obtained by dividing the sum of values by the number of
samples.

3. Sum - On selecting this option, PerformanceManager adds metric values to arrive at a sum.

4. Minimum - On selecting this, PerformanceManager uses the lowest numeric value.

5. Maximum - On selecting this, PerformanceManager uses the highest numeric value.

6. Last - On selecting this, PerformanceManager uses the last value read from the data source.

7. Count - On selecting this, PerformanceManager uses the number of records from the data
source that are combined into each point.

Add a Filter

Follow these steps:

PDF version of Online Help
Chapter 2: Getting Started with HP PerformanceManager

HP PerformanceManager (9.20) Page 38 of 93



1. In the first drop-down list, select themetric for which you want to apply the filter.

2. From the second drop-down list, select one of the comparison operators.

3. Enter the value against which the comparison is done in the text box.

4. Click Add.

5. Click OK. TheMetric Selection screen of the design wizard appears.

Example: The filterAPP_NAME~.*Application.*filters data where the application name contains
the text "Application".

Specify Multiple Filters

Follow these steps:

1. In the first drop-down list, select themetric for which you will apply the filter.

2. From the second drop-down list, select one of the comparison operators.

3. Enter the value against which the comparison is done in the text box. Select the appropriate
AND orOR operators. By default, "AND" is selected.

Note: You can select either "AND" or "OR" option. You cannot specify a combination of
these two options.

4. Click Add. Click OK. TheMetric Selection screen of the design wizard appears.

The following table lists the logical operators:

Symbol Description

&& Both filter conditions must match

|| One of the two filter conditions must match

@ Capture all values from the data source

Logical Operators

Update a Filter

Follow these steps:

1. Click on the filter which you want to update from the list of filters in theMetric Properties
window. The selected filter will now be displayed on the drop-down list.

2. Click Update. Update the filter.

3. Click OK. TheMetric Selection screen of the design wizard appears.

Remove Filters
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You can remove one or all filters which you specified:

To remove a filters, follow these steps:

1. Click on the filter which you want to remove from the list of filters in theMetric Properties
window.

2. Click Remove.

3. Click OK. TheMetric Selection screen of the design wizard appears.

To remove all filters, follow these steps:

l Click Remove All. All the filters specified for this metric is removed.

Metric Selection

This page allows you to do the following:

1. AddMetrics

2. DefineMetric Properties

If you are editing a graph, the fields specified below are populated with the values specified in the
graph template. However you canmodify these values. The name of the graph which you are
currently editing appears in the title of the design wizard page.

Themetrics you select and themetric properties which you have specified while designing a graph
will be saved in the graph template.

1. Click Next to go to the next page orPrev to go to the previous page.

2. Click Save orSave As to save the graph. TheSavewindow appears. Youmust enter the
following:

a. Family - Enter the name of the graph family

b. Category - Enter the name of the graph category

c. Name - Enter a name for the graph

If the family name and category already exists, PerformanceManager automatically
populates the Family, Category and Name fields text boxes with the names when you type
the first few alphabets.

3. Click Preview to preview the graph. To go back to design wizard from the preview page, click
Back to Design. Based on the type of the graph you are designing, the design wizard takes you
to the next step:

a. If you are designing a normal graph and if you have selectedmulti-instancemetrics, the
Select Instances pop-up appears. Select the instances you want to compare and click OK.

PDF version of Online Help
Chapter 2: Getting Started with HP PerformanceManager

HP PerformanceManager (9.20) Page 40 of 93



b. If you are designing instance comparison graphs, theSelect Instances pop-up appears.
Select the instances for which you want data and then click OK. Youmust select at least
two instances to compare. However, you can also select one instance.
Tip: To view the list of the available instances, drag the bottom-right end of the Instance
selection window, in the direction of the arrow displayed.

c. For system comparison graphs, theSelect a Node pop-up appears. Select a system to
compare with and click Draw.

d. If you are designing a Forecast graph, specify planner options.

4. Click Cancel to exit the design wizard.

Planner

Planner is based on time-series based statistical forecasting techniques. You can design and draw
forecasting graphs using planner. Perform the following tasks:

1. Select the Trending Method required. By default, 'Smoothing' is selected. Click here for more
information about different types of forecast graphs. Select from the options available:

l Smoothing

l Linear

l Exponential

l S-curve: If you have selected S-curve option as the trendingmethod:

o S-Curve Min: Enter theminimum values for the S-curve. The default value is 0. The
value you specify here determines theminimum value that ametric forecast is allowed
to have.

o S-Curve Max: Enter themaximum values for the S-curve. The default value is 100.
The value you specify here determines themaximum value that ametric forecast is
allowed to have.

l Business Units: If you have selected Business Units as a trendingmethod: A business unit
is ameasure of business activity that can be correlated to the activity of a critical system
resource. If there is a strong correlation, business units can be used for accurate projections
of performancemetrics.

n Example: A business unit for an order processing system can be the number of orders
processed, number of mail messages processed, number of customers or users.

l Business Metric: The business unit file which contains the business metric must be
available on the PerformanceManager server. The business unit file can be uploaded only
by the PerformanceManager administrator. For more information on business unit file, refer
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to theHP PerformanceManager Administrator Guide.

To use a business unit:

1. Click Source. TheBusiness Units: Select Node dialog box appears.

2. Select the business unit file which contains the business metric.

3. Click OK. TheBusiness Units: Data Source Selection dialog box appears with
FILE(FILE) as a preselected option.

4. Click OK. TheBusiness Units: Metric Selection dialog box appears.

5. Select themetric which you want to use for forecasting. You can select only one
metric. Click OK.

Tomodify themetric or the business file:

1. Click Edit.

o If you have already selected a business file and a business metric, the
Business Units: Metric Selection dialog box appears. Go to step 3.

o If you click Edit before selecting a business file, TheBusiness Units: Select
Node dialog box appears. Follow steps 2 to 5 of the section To use a Business
Unit to select a business metric.

2. Select the business metric which you want to use for forecast.

Date Range: The default date range is: 7 days ending 'Now' and Points Every value is auto
summarization. You can alsomodify default settings for date and time by forecasting date
range. If you have specified this value in the Graph Attributes screen, the same value appears
here.

Note:

n When you specify the points every value, make sure you specify a value which is in
synchronization with the data available in the business unit file. For example: If you have
a business metric of number of orders on a hourly basis, make sure that you specify
points every value as "hour".

n It is important that the business unit file contains historical and future predicted values of
data until the forecasting end date.

Confidence Lines

Youmust specify the interval type and confidence level.

Interval Type - Select the interval type for the forecast graph. The default option is 'none'.
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An interval is a statistical range in which the forecast falls. This range is shown on your
forecast as lines defining the upper and lower limits. Planner supports two types of intervals:
Confidence Interval and Prediction Interval.

The confidence interval is much narrower then the prediction interval. The confidence
interval defines a range in which the average of the predicted values (the trend line) fall in the
given percentage of the time. The prediction interval defines a range in which the predicted
values (all points) fall in the given percentage of the time. The rangemust be wider for the
prediction interval because there is more variability in the forecasted values then there is in
themean of the forecasted values. Confidence lines are disabled for a smoothing forecast
graph.

Confidence Level - Specify the Confidence Level percentage for the specified interval type.
The options available are: 70%, 80% and 90%. The Confidence Level is set to 70% by
default.

A higher value for confidence level, for example 90%, sets a wider range, since it indicates
that the upper and lower limit curves should encompass a larger percentage of the values. If
you select the Interval type as "None", this option is disabled.

Show validation data - Selecting this option allows you to check the validity of a forecast.
When you select this option, the forecast graph displays any data found after the Ending
Date and before the Forecast Ending date. This data is displayed, but is not used in
forecasting. This data can be used to compare the forecast with the actually data during that
duration.

Seasonality: Seasonality refers to a pattern of variation in data that is related to specific
time intervals (seasons). Metric data can vary in a pattern based on the hour of the day or
day of the week. These patterns of usage can dilute the accuracy of a forecast if they are not

Seasonality Pattern varies for Only valid when

Hour of the Day each hour of a 24 hour day Points Every <= 1 hour

Day of theWeek each day of a 7 day week Points Every <= 1
week

Points Every <= 1
week

Duration > 1 week

Week of the
Month

each week in themonth, based on

calendar months

Points Every <= 1 day

Duration > 30 days

Month of the Year each calendar month of the year Duration > 3months

Example: If your company is on a 5-day work week, you can see day-of-the-week
seasonality because your systems do little work, if any, on the weekends. Firms that
process orders often experience week-of-the-month seasonality as themonth-end
approaches and sales quotas must bemet.

Note:
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l Seasonality and Confidence Lines are not available for smoothing.

l Seasonality is not applicable for business units.

l Even if you specify one or more of the available options for seasonality, the options are
applied only if they improve the forecast.

Special Attributes

1. You can define attributes specific to the graph type you selected:

a. Line, Area, Bar graph

b. Table

c. Forecast Graphs

Note: This option is not available for XML, CSV, Baseline and TSV graph types.

If you are editing a graph, all the attributes specified are saved in the graph template and appear
preselected. The name of the graph which you are currently editing appears in the title of the design
wizard page.

2. Click Next to go to the next page orPrev to go to the previous page.

3. Click Save orSave As to save the graph. The Save window appears. Youmust enter the
following:

l Family - Enter the name of the graph family

l Category - Enter the name of the graph category

l Name - Enter a name for the graph

If the family name and category already exists, PerformanceManager automatically populates the
Family, Category, andName fields text boxes with the names when you type the first few
alphabet.

4. Click Preview to preview the graph. To go back to design wizard from the preview page, click
Back to Design.

Note: For normal and instance comparison graphs, TheSelect Instances pop-up appears.
Select the instances you want to compare and click OK. For system comparison graphs, The
Select a Node pop-up appears. Select a system to compare with and click Draw.

5. Click Cancel to exit the design wizard.
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Note: If the graph is a table graph you can specify the highlight data and filter.

Other Attributes

1. In this page you can specify the following options:

Note: If you are editing a graph, all the 'Other Attributes' specified will be saved in the
graph template and will appear preselected. The name of the graph which you are currently
editing appears in the title of the design wizard page.

n Graph Header - Specify a description for the graph. The description appears at the top of the
page. The description appears only in the print view.

n Graph Trailer - Specify a description for the graph. This description appears at the bottom of
the page. The description appears only in the print view.

n Pixels - Specify the pixels for the graph

o Width: The width of the graph image file in pixels (default=700).

o Height: The height of the graph image file in pixels (default=500).

Note: If the width and height specified for the graph aremore than the window size,
horizontal or vertical scroll bars are displayed. You can view the graph using using the
scroll bars. The window size depends on the browser window size.

2. Click Next to go to the next page orPrev to go to the previous page.

3. Click Preview to preview the graph. To go back to design wizard from the preview page, click
Back to Design.

Note: For normal and instance comparison graphs, TheSelect Instances pop-up
appears. Select the instances you want to compare and click OK. For system comparison
graphs, TheSelect a Node pop-up appears. Select a system to compare with and click
Draw.

4. Click Cancel to exit the design wizard.

Finish

After you save the graph, the design wizard displays the followingmessage:

You have successfully designed a graph with the DesignWizard!

l Click Design Another Graph if you want to design another graph.

(or)
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l Click Home if you want to go to the home page. The graph you designed is listed in theSelect a
Graph pane on the home page.

Line, Area, Bar Graph

You can specify the you want the look and feel of the graph to appear. Select from one of the
following options:

l Background color: Click Color, to select a background color.

l Legend Font color: Click Color. The color picker pop-up appears. Select a color.

l Left Y Axis

n Label - Specify a label for Y Axis appearing on the left side.

n Minimum - Specify minimum value for points on the left side Y-Axis. If left blank, the initial
scale of the axis will automatically be adjusted to accommodate the values in the graph.

n Maximum - Specify maximum value for points on the left side Y-Axis. If left blank, the initial
scale of the axis will automatically be adjusted to accommodate the values in the graph.

l Right Y Axis

n Label - Specify a label for Y Axis appearing on the right side. This allows you to specify a label
for the right side of the graph to identify the right hand Y-Axis. This field does not appear unless
at least onemetric has the "Right Y-Axis" selected from Metric propertieswindow.

n Minimum - Specify minimum value for points on the right side Y-Axis. If left blank, the initial
scale of the axis is automatically be adjusted to accommodate the values in the graph.

n Maximum - Specify maximum value for points on the right side Y-Axis. If left blank, the initial
scale of the axis is automatically adjusted to accommodate the values in the graph.

Note: This option is available only for graph types 'line', 'area', and 'mixed'. For all other graph
types, this option does not appear on the screen.

l Metrics per graph - Specify the number of metrics you want to see in a graph. The default
value is 8.

n Single graph - Select Single Graph checkbox, to limit the number of graphs to one graph when
number of metrics or instances exceed the value specified for "Metrics per Graph".

n Multiple graphs - Select Multiple Graphs checkbox, to display multiple graphs when number
of metrics or instances exceed the value specified for "Metrics per Graph". The number of
metrics or instances in each graph will be less than or equal to the value specified for "Metrics
per Graph".
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l Metric Display order - Specify the order in which you want themetrics to be displayed. The
default value for instance comparison graphs and system comparison graphs is 'Sort by
average'. The default value for other types of graphs is 'User defined'. You can select from the
following options:

n User defined - Themetrics appear in the order in which you select while addingmetrics. You
can also specify the order of metrics.

n Average - Themetrics appear in the descending order of the average value.

n Reverse Average - Themetrics appear in the ascending order of the average value.

Note:

l Valid scenarios forAverage andReverse Average display order options are comparison
graphs such as instance comparison, system comparison or top N graphs.

l This option is available for line, area and bar graphs. This option is not available for table,
baseline, forecast graphs.

l You can configuremaximum number of graphs using the configuration parameter
SORTBY_MAX_GRAPH_COUNT in the file OVPMConfig.ini. For more information, refer
to theHP PerformanceManager Administrator Guide.

Color Selection

To select a color from the color palette, perform the following tasks:

1. From the color palette, click on the vertical bar to select the color you want.

2. The left pane displays the available hues or shades of a particular color. Click on a required hue
to select the same.
(or)
You can also enter the values for Red, Green, and, Blue to select a particular color. The
selected color is displayed on theSelected Color box.

3. Click OK to select orCancel to go back to design wizard.

Designing a Normal Graph

Once you select Normal Graph, the design wizard takes you through the steps to design a Normal
graph:

Node Selection

Data Source Selection
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Graph Attributes

Metric Selection

Special Attributes

Other Attributes

Finish

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.

Designing a System Comparison Graph

Once you select System Comparison Graph, the design wizard takes you through the steps to
design a System Comparison graph:

Node Selection

Data Source Selection

Graph Attributes

Metric Selection

Special Attributes

Other Attributes

Finish

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.
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Designing a Instance Comparison Graph

Once you select Instance Comparison Graph, the design wizard takes you through the steps to
design a Instance Comparison graph:

Node Selection

Data Source Selection

Graph Attributes

Metric Selection

Special Attributes

Other Attributes

Finish

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.

Designing a Multi-source Graph

Once you select Multi-source graph, the design wizard takes you through the steps to design a
Multi-source graph:

Node Selection

Data Source Selection

Graph Attributes

Metric Selection

Special Attributes
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Other Attributes

Finish

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.

Designing a Forecast Graph

Once you select Forecast Graph, the design wizard takes you through the steps to design a
Forecast graph. Click here for some information about statistical forecasting:

Node Selection

Data Source Selection

Graph Attributes

Metric Selection

Planner

Special Attributes

Other Attributes

Finish

l Click Next to go to the next page orPrev to go to the previous page.

l Click Cancel to exit the design wizard.

You can specify the following special attributes for a forecast graph:

l Background color: To select the background color, Click Background Color.

l Legend Font Color: Click Color. The color picker pop-up appears. Click here for instructions to
select a color.

l Left Y Axis:
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n Label - Specify a label for Y Axis appearing on the left side.

n Minimum - Specify minimum value for points on the left side Y-Axis. If left blank, the initial
scale of the axis is automatically adjusted to accommodate the values in the graph.

n Maximum - Specify maximum value for points on the left side Y-Axis. If left blank, the initial
scale of the axis is automatically adjusted to accommodate the values in the graph.

Designing a Graph for Reporter

You need to configure Reporter as a data source. For more information, refer toPerformance
Manager Administrator Guide.

1. Select Normal Graph.

2. Click Next. TheNode Selection page appears.

3. Click Nextwithout selecting any node. By default Reporter is selected.

4. Click Next the design wizard takes you through the steps to design a Normal graph:

Data Source Selection

Graph Attributes

Metric Selection

Special Attributes

Expert Options

Editing Graphs

You can edit a graph definition and save your changes.

Note:

l You can edit out-of-the-box graph definitions, but you can only save it with a different name.
Out-of-the-box graphs are read-only.

l User-defined graphs can either be saved with changes or you can save it as a new graph.
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l While editing a Business unit forecast graph, the flat file selected while designing will
appear pre-selected as long as the flat file used for designing is available in the appropriate
location on the PerformanceManager server. You canmodify this selection from the
Planner screen of the design wizard while editing a graph.

To edit a graph definition, follow these steps:

1. Click View→Design wizard. The DesignWizard window appears.

2. Select Edit an Existing Graph and click Next. TheGraph Selectionwindow appears. You
can reload the graphlist to view themost recent changes made. To reload graph list click
Graphs→Reload Graphlist. You can only view the changes made by another user with the
same login credentials in a different session.

3. Select the graph which you want to edit. Click Next. The design wizard displays the name of
the graph in the title of the design wizard page. The design wizard takes you through the series
of steps to edit the graph:

Node Selection

Data Source Selection

Graph Attributes

Metric Selection

Special Attributes

Other Attributes

Finish

Managing Favorite Graphs
You can create a list of favorite graphs, which you need to view frequently. Themaximum number
of graphs you can save as favorites is 10. You can perform the following tasks:

Add a graph as favorite
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After you draw a graph, you can add the graph as your favorite. To add a graph as your favorite,
perform the following tasks:

1. From themenu, click Graphs→Add to Favorites. TheSave dialog box appears.

2. Enter a name for the favorite graph. By default the graph Family name is Favorites.

Note:

n If you want to add a favorite graph as a home page, from theSave dialog box, select the
checkbox Set this graph as a Home page. When you log in to PerformanceManager,
this favorite graph is displayed as the home page.

n To disable the graph from appearing as the home page, delete the Favorite graph that is
set as the home page. If you want to retain the graph template, save the graph with a
different name before deleting.

3. Click OK to save orCancel to cancel and exit. When you click OK, the followingmessage
appears:

The <name of the graph> graph has been saved successfully.

4. Click OK. This graph is saved as a favorite and appears in the list of favorite graphs in theMy
Favorites pane.

View Favorite Graphs

You can view favorite graphs in the following ways:

1. From themenu bar, click View→My Favorites. TheMy Favorites pane displays a list of all
favorite graphs.

2. From the home page, you can also view the list of favorite graphs in the Graph tree on the right
pane.

Draw Favorite Graphs

From the home page:

1. Select the favorite graph from the graph tree on the right pane. Click Draw. The graph is
displayed on the same page.

2. In case you select a node from the node tree, this selection overrides the node saved in the
graph template.

From themenu bar:
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1. Click View→My Favorites. TheMy Favorites pane displays a list of all favorite graphs.

2. Select the favorite graph which you want to draw.

3. Click Draw. The graph is displayed on the same page.

Delete a Favorite Graph

1. From the list of favorite graphs on theMy Favorites pane, select the graph that you want to
delete. TheDelete button appears on the bottom of the left pane.

2. Click Delete to delete the favorite graph. A message asking you to confirm deletion appears.

3. Click OK and the followingmessage appears:

The <name of the graph graph> has been deleted successfully.

4. Click OK.

Close My Favorites Pane

To close theMy Favorites pane:

l Click icon on the top right corner of theMy Favorites pane.

l Click on the arrow available on border of the pane, which separates the graph andMy Favorites
Pane.

Note:

l You can draw a favorite graph without specifying the node and the date range. When a
favorite graph is drawn, it uses the node and date range that was previously used to save a
drawn graph as favorite.

l If you delete a favorite graph, it is deleted from the PerformanceManager.

Overview of Planner
HP PerformanceManager provides a feature called Planner to forecast system resource
consumption. You can use planner to design and draw forecast graphs which can be used for
capacity planning.

Capacity planning is a process designed to ensure that sufficient system resources are available to
maintain acceptable performance levels. Capacity planning is different from day-to-day
performancemanagement, troubleshooting or tuning because the focus is on planning future
resources tomeet changing business demands. Hence capacity planning is an important part of
managing an adaptive enterprise. This is an on-going process which requires continuous

PDF version of Online Help
Chapter 2: Getting Started with HP PerformanceManager

HP PerformanceManager (9.20) Page 54 of 93



monitoring. This process enables you to ensure that system users receive the required level of
performance to work effectively.

Capacity planning begins with collection of performance data. For PerformanceManager data is
collected through data sources. Examples of data sources: HP Performance Agent (PA),
Embedded Performance Component (EPC), Repsys (nodes from HP Reporter), and Agentless
(nodes from HP SiteScope). Based on the performance data gathered by the data sources, you can
use planner for capacity planning and predict the future service demands of system resources.

Planner is based on time-series based statistical forecasting techniques.

Statistical Forecasting

Statistical Forecasting is a technique useful in planning for capacity changes. Planner is based on
time-series based statistical forecasting techniques. Statistical Forecasting uses historical trends
to predict future trends, can be used to examine subtle variations in data, types of trends,
seasonality, and significance and provide indication of confidence in results. Statistical forecasting
is not useful in predicting performance for your workload on alternate configurations or doing
extensive "what if" analysis.

In statistics, a trend is a change, tendency, or pattern in a series of data over a period of time after
other components have been accounted for.

You can use Planner to makemore reliable decisions on when to acquire additional resources or
adjust system load tomeet changing demands. Use the planner feature to forecast system
resource utilization and capacity planning.

Planner also provides you options to enhance your forecasts by adding interval bounds. An interval
is a statistical range within which the forecast falls. This range is shown on your forecast as lines
defining the upper and lower limits. Planner supports two types of intervals namely Confidence
Interval and Prediction Intervals.

To do statistical forecasting youmust do the following:

1. Measure the workload by collecting performance data. Performance data is collected from data
sources: HP Performance Agent (PA), Embedded Performance Component (EPC), Repsys
(nodes from HP Reporter), and Agentless ( nodes from HP SiteScope).

2. Characterize the typical workload.

3. Use the performance data gathered to visualize the future capacity trend and generate a
forecast.

You can design and draw forecasting graphs using planner.

Types of Forecasting Graphs
You can design and draw forecasting graphs using planner. Listed below are the various types of
forecasting performed by PerformanceManager. The choice of trendingmethodmay be based on
knowledge of themetric behavior:

Smoothing
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A smoothingmethod is used tomake it easier to determine a trend in the data. The smoothed graph
does not extend beyond the existing data to predict or forecast future data values; it just shows the
trend in the existing data. Smoothing techniques are used to reduce irregularities (random
fluctuations) in time series data. Select this option to determine a trend in the data. On a smoothed
graph, mean values replace the actual data values, to produce a smooth curve. A Smoothed curve
makes it easier to see any trend over time. On a smoothed graph, you'll see the actual data
collected and a smooth curve based onmean values replacing data values. A smoothed curve
removes some of the variability in the data andmakes it easier to see any trend over time. You can
use the smoothing curve to detect potential disruptions to themetric values that youmay want to
accommodate in your date range selections.

Linear

The forecast equation for Linear Trending is as follows:

Y = slope X + intercept

Where,

l "Y" represents themetric value plotted against the Y-Axis in the graph

l "X" represents the X-Axis value. By default this is usually the time, expressed as a "point
number". The first displayed value is point 0, the next is point 1, and so on.

This is themost commonly used trendingmethod.

Exponential Trending

The choice of trendingmethodmay be based on knowledge of themetric behavior. Exponential
trending is useful when you know that themetric values tend to behave in a non-linear fashion. An
example of a good use of the Exponential trendingmethod is when forecasting response time
values. For Exponential forecasts, the equation is as follows:

Y = exp(slope X + intercept)

Where,

l "Y" represents themetric value plotted against the Y-Axis in the graph

l "X" represents the X-Axis value. By default this is usually the time, expressed as a "point
number". The first displayed value is point 0, the next is point 1, and so on.

The "exp" function returns the exponential number e (i.e., 2.718...) raised to the power of its
argument.

S-curve Trending

An S-Curve trendingmethod fits an "S" shaped curved line to the data. The curve assumes that
there areminimum andmaximum values that it can approach but never actually achieve. The S-
Curvemethod is often useful for forecasting boundedmetrics such as CPU Utilization. CPU
Utilization can never be less than zero or more than 100. When using the S-Curve trendingmethod,
youmust ensure that the S-CurveMin and S-CurveMax values in the Planner tab are set properly
to theminimum andmaximum value that the S-Curve can achieve. For S-Curve forecasts, the
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equation is as follows:

Y = YMax / (exp(slope X + intercept)+1)

Where,

l "Y" represents themetric value plotted against the Y-Axis in the graph

l "X" represents the X-Axis value. This is usually the time, expressed as a "point number". The
first displayed value is point 0, the next is point 1, and so on.

"YMax" is themaximum value for themetric as selected in the PerformanceManager user
interface.

Business Units

While designing a forecast graph, use the Business Unit trendingmethod to forecast the impact of
changes in a business unit on your system. You need to create a Business unit file (a flat file in
ASCII format) to upload the business data to PerformanceManager for analysis and forecasts. To
create a business unit file:

1. Identify the business unit.

2. Gather historic data on the business unit.

3. Gather expected future values for the business unit.

4. Consolidate the data into a business unit file. This is typically an ASCII file. For more
information on the format supported by PerformanceManager, see theHP Performance
Manager Administrator Guide.

5. Correlate the business unit to ametric.

Example: The number of orders can be a business unit for an order processing system. This can be
a business metric which can be used to forecast CPU utilization (GBL_CPU_TOTAL_UTIL) of the
order processing system.

The business unit file can be uploaded only by a PerformanceManager Administrator. For more
information on the format and location of flat files, refer to theHP PerformanceManager
Administrator Guide.

Validating Forecasts
After you have produced a forecast, youmust validate it to confirm that it reasonably represents the
system that it is designed to represent. The following tools are used to validate a forecastingmodel:

l Performance Experience

l Show Validation Data
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l Confidence Interval and Prediction Interval

l Statistical Measures

Validating a forecastingmodel means testing themodel to see if it seems likely that the forecast
generated is accurate enough to be useful. You can use any or all of the listed tools to validate the
forecastingmodel. It is not necessary to use all of them. Inmany cases, you can determine
forecast validity by using just a few of the validity tools listed here.

If the forecast is not valid, youmay repeat the process of designing a forecast graph by modifying
options that may allow generation of a valid forecast. Planner allows you to perform forecast on a
trial and error basis because it allows you to easily change the options (such as Points Every, Date
range) preview the graph and switch to design wizard tomakemore changes. To improve the
forecast you canmodify some values such as: the date range, enable or disable seasonality, a
different forecastingmethod, or looking at a subset of application data.

It may be helpful if, after obtaining a successful forecast, you repeat the forecast with minor
changes. For example, if the forecast is dependent on the exact date range that you have specified.
If you get a forecast that predicts an increase in value, but a slightly different date range gives you
a decreasing trend then the forecast might not be valid.

Performance Experience

The experienced system performancemanager understands the variables that affect system
performance and knows what behavior is reasonable. Using the reasonability test helps one avoid
ludicrous results in a forecast.

Show Validation Data

The Show Validation Data option in Planner lets you use a portion of the actual recorded set of
performance data to validate the forecast. Any data found after the "Date Range: Ending" date is
not used for the forecasting calculation but then is included after the forecast is generated. You can
then compare the predicted data to the corresponding portion of actual data to evaluate the
accuracy of the trendingmethod.

If the forecasted data and the actual data are close, this increases your confidence in the trending
method and lends credibility to the forecast values past the validation data. If, however, the
forecasted values and actual data differ a great deal, it is strong evidence against the validity of the
trendingmethod or other forecast settings.

Confidence Interval and Prediction Intervals

Confidence and Predictions are a visual way to indicate the quality of a forecast. You can specify
the interval type while designing a forecast graph. When you specify these intervals, two extra lines
appear in the graph to indicate the Upper and Lower limits. This defines a range of values around the
forecast curve.

l Confidence Interval: It is an interval (range of values) which defines the range (the upper and
lower limit) within which there is a specific probability that the average of the predicted values
fall in the given percentage of the time.
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For example, a 95% confidence interval is an interval such that the chance of the predicted
values lying within that interval is 95%.

l Prediction Interval: it is an interval which defines the range within which there is a specific
probability that all the predicted values fall within the given percentage of the time.

A Prediction interval is always wider than a Confidence interval for the same forecast. A confidence
interval encloses themean values while a prediction interval has to enclose all the points. The
range is wider for the prediction interval because there is more variability in the forecasted values
than there is in themean of the forecasted values. A narrow interval (small spread between the
upper and lower bounds) tends to indicate a valid or credible forecast. Conversely, a broad interval
indicates a less credible forecast.

Statistical Measures

After you draw a forecast graph, from themainmenu, click Graphs -> Print. The print view of the
forecast graphs displays information such as the forecast equation and Correlation co-efficient. You
can use the following information to interpret the accuracy of the forecast:

Statistics Range of
Values

Interpretation

Correlation
Coefficient

-1 to 0 Indicates that the forecast is decreasing, A value closer
to -1 is accurate

Correlation
Coefficient

0 to 1 Indicates that the forecast is increasing, Closer to 1 is
accurate

Estimated Standard
Error

0 tometric
value

Lower is accurate (same units as the forecast metric)

Variance as a
function of …

0 to 100% Higher is accurate

The print view of the graph displays the forecast equation.

In this equation,

l "Y" represents themetric value plotted against the Y-Axis in the graph

l "X" represents the X-Axis value. This is normally the time, expressed as a "point number".

The first displayed value is point 0, the next is point 1, and so on. The rest of the equation depends
on the type of trendingmethod selected.

For Linear forecasts, the equation is as follows:

Y = slope X + intercept

Where slope and intercept are numbers and X is usually the number of time periods since the start
of the forecast. A negative slopemeans that the forecast is decreasing as time increases.

For Exponential forecasts, the equation is as follows:
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Y = exp (slope X + intercept)

The argument in the parentheses is the same as the linear equation. You need to know the
intercept, slope, and the number of time periods from the beginning of the forecast. Calculate the
value of the equation within the parenthesis and then you calculate exp or the exponential number e
(i.e., 2.718...) raised to the power of that argument.

For S-Curve forecasts, the equation is as follows:

Y = YMax / (exp(slope X + intercept)+1)

YMax is themaximum value for themetric as selected in for forecasting.

If you want to be able to calculate the forecast value in other tools (such as spread sheets) then you
should be able to transfer these equations, providing you follow the rules for providing X values.

Interpret Statistical Numbers

You can refer to the descriptions of the statistical measures to interpret the forecast. You can use
one, several, or all of these validity checks to analyze your forecast. Typically you will use common
sense, confidence intervals, and the statistical measures to validate your forecasts. If the forecast
fails any of the validity checks, it is not valid. You can then either repeat the forecasting process
again to try to develop a valid forecast, or you can decide that a valid forecast is not feasible. It is
possible that the chosen forecast metric has behaved in an unpredictable manner during the
measurement period that you selected. The statistical measures are described below.

Correlation Coefficient

The Correlation Coefficient is often referred to as "r" or "R" in many statistics books. It has also
been called the "product-moment coefficient correlation" or "Pearson's correlation". The correlation
coefficient measures the tightness of fit of the forecast line to the actual metric values.

The correlation coefficient ranges from -1 to 1. Negative R values indicate that the slope of the line
is negative (that is, the line goes down and to the right). Positive R values indicate that the slope of
the line is positive (that is, the line goes up and to the right).

A correlation coefficient with an absolute value of 1 represents a perfect fit (either +1 or -1) and a
correlation coefficient of 0 represents a bad fit. The closer your forecast's correlation coefficient is
to 1, the better the forecast line fits the data. A correlation coefficient of 0 indicates that the forecast
is not very accurate.

Estimated Standard Error

The Estimated Standard Error, often called simply "Standard Error" is ameasure of how well the
forecast line fits the data points. It is calculated by taking the distance between the forecast line
and the actual data value at each point. Tomake the calculations work we actually sum the square
of this difference and when we are done, take the square root of this value divided by the number of
points. A value for Standard Error close to 0 is optimal.

The units of the Standard Error are the same as the units of the forecast metric. Thus, if you are
forecasting Response Time in seconds and get a Standard Error of 2.5 then you can assume that
"typically" the forecast is 2.5 seconds away from the actual data. The Estimated Standard Error
value is not dependent on how well the X value predicts the forecast metric. Instead it shows how
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close the forecast line lays to the actual data points. For this reason, a small Estimated Standard
Error value can indicate a good forecast even when the forecast metric does not vary much.

Squared correlation or R-squared

R-squared or the squared correlation is the proportion of the variation in themetric that is explained
by time. The value for R-Squared is expressed as a percent and is shown in the PM forecast graph
statistics report in the line:

Approximately <value> percent of the variance in themetric can be explained as a function of time.
Where value is the R-Squared value times 100%.

R-Squared is the square of the correlation coefficient R (described above). R-Squared is always a
positive value between 0 and 1, with values closer to 1 indicating better forecasts. R-Squared is
also called the Coefficient of Determination.

Note: Both the Correlation Coefficient and R-Squared values indicate how well the forecast
metric can be predicted by the X value (time). If themetric value is not changing relative to the
X value then these numbers are almost close to zero, indicating a bad fit. This doesn't mean
that the forecast line cannot be trusted. It merely means that the X values chosen are not
effective at predicting changes in the forecast metric.

Example: If your forecast metric always has the same value (say 5.0) then as time changes the
forecast metric value stays the same. The forecast displays a slope of zero, indicating no change,
and the R and R-squared values is equal zero. On the other hand, if the forecast metric is equal 5.0
then it is likely to remain at this value so the forecast line, predicting 5.0 into the future, may well be
accurate. See the Estimated Standard Error measure for a different approach tomeasuring forecast
validity.

Related Documentation
Listed below are the documentation available for PerformanceManager:

Title Location Description

HP Performance
Manager
Tutorials

From the PerformanceManager
home page, Click Help ->
Tutorials

Refer to the tutorial for instructions to
use HP PerformanceManager.

HP Performance
Manager
Administrator
Guide

<Install_dir>\paperdocs\PM\C If you are an administrator, refer to this
guide.

Performance Manager Documentation
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Title Location Description

HP Performance
Manager
Installation,
Migration, and
UpgradeGuide

Included on the product's DVD
media as:

\paperdocs\PMInstallGuide.pdf

(or)

Click Installation Guide on the
Installation home page

This guide provides instructions to
install the product. This guide also
includes information about the system
requirements, configuration tasks and
pre-requisites to install Performance
Manager.

Performance Manager Documentation, continued

Administrator Tasks
If you are a PerformanceManager administrator, you can perform the following tasks from the
Standard-view:

l "Manage Nodes" below

l "Manage Users" on page 64

Manage Nodes
The PerformanceManager Admin User Interface allows you tomanagemulti-level node-groups.
You can add or delete only PerformanceManager specific nodes and node groups. Non
PerformanceManager nodes and node groups that does not belong to PerformanceManager, for
example, HP Reporter, HP Operations Manager, and HP SiteScope cannot be deleted from the
Admin page.

You can view the system information of a node. From themenu bar, click Admin -> Manage
Nodes. TheManage Nodes screen appears. You can perform the following tasks:

Add a Node Group

A node group can be added at different levels in a node tree. You can add a sub group to a node
group. If you have not selected any node groups, a new group will be added to the top level.

To add top level node groups, perform the following tasks:

1. Click . Enter the name of the node group in theAdd a Node Group pop up window.

2. Click Add, to add a new node group.

To add sub level node groups to the existing top level node-group, perform the following tasks:

1. Expand and select the node group to which you want to add the new sub node group. To select
a node group, click on the check box adjacent to the node group.
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2. Click . Enter the name of the node group in theAdd a Node Group pop up window.

3. Click Add, to add the new sub group under the selected node group.

Note: If you add a sub node group under a non PerformanceManager node group, all the nodes
and the node groups under the sub node group are converted to a PerformanceManager node
group.

Add a Node

 You can select a node group either at the top level or at any level in the node tree to add a node. To
add a node, perform the following tasks:

1. Select a node group or node sub group to which you want to add a node by clicking on the
checkbox next to the node group.

2. Click and enter the name of the node group in theName text box below the node tree. The
node is added to the group selected.

Nodes can be added only to a group or sub group. If the PerformanceManager administrator makes
any changes to a node group, the node group appears collapsed in other pages such as HomePage
and DesignWizard. Expand the node group to view any new changes to the list of nodes or node
groups.

If you add a node under a non PerformanceManager node group, the node group is converted to a
PerformanceManager node.

Delete a Node Group

You can only delete PerformanceManager node groups and the respective sub groups from the
Admin User Interface. To delete a node group, perform the following tasks:

1. Select the PerformanceManager node group or sub group you want to delete by selecting the

check box adjacent to the node group. Click theDelete icon . A message asking you to
confirm if the node group is to be deleted appears.

2. Click OK. All the sub level node groups and all the nodes which belong to the top level node-
group are deleted or click Cancel to exit from this window.

If you select to delete the sub group, only the sub group and the nodes belonging to that sub group
are deleted.

In theManage Nodes option of theAdminmenu you cannot delete non PerformanceManager
node groups. Only PerformanceManager specific node groups can be deleted.

Delete a Node

To delete a node, perform the following tasks:
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1. Select the node which you want to delete by clicking on the check box adjacent to the node.

Click theDelete icon . A confirmationmessage asking if you want to delete the node
appears. In addition, the confirmationmessage includes a checkbox, Delete the node(s) from
all groups. Select this option if you want to delete the node(s) from all the groups to which it
belongs.

2. Click OK to delete the node with required option orCancel to exit from this window.

In theManage Nodes option of theAdminmenu you cannot delete non PerformanceManager
nodes. Only the respective node groups are visible. However, you can delete for Performance
Manager nodes and node groups.

Search for a Node or Node Group

To search for a node or a node-group, perform the following tasks:

1. Enter the name of the node or node group which you want to search in the text box below the
node tree. Click theSearch icon .

2. If the node or node group is present in the node tree, the node or node group will be highlighted.

3. If the node or node group is not present in the node tree, then amessage stating that the node
or node group is not found appears.

In theManage Nodes option of the Adminmenu, you cannot search for HP Operations Manager,
HP Reporter, and HP SiteScope Server nodes. Only the respective node groups are visible.
However, you can search for PerformanceManager nodes and node groups.

If a node group belongs to a PerformanceManager and a non PerformanceManager, only the nodes
under PerformanceManager will be displayed and can be searched.

When you search for a node, PerformanceManager highlights only the first 10 nodes matching the
search string. To narrow down your search, you need to specify appropriate search strings. Also,
the search operation cannot highlight a node where SiteScope is installed.

View System Information

To view the system information for a node, Select the node and click theSystem Information icon
.

The system information of the selected node appears in a new page. The system information
includes details such as: System ID, the Data source, Data communication protocol, Number of
disks and CPUs available, Operating system name, Operating system version, list of key metrics
and available metric classes and list of instances and number of instances available for eachmetric
class.

Manage Users
The PerformanceManager Admin User Interface allows you tomanage customers and users. You
can also attach node groups to customers. From themenu bar, click Admin -> Manage Users.
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TheManage Userswindow appears. This page displays a list of customers and users configured
to use PerformanceManager. From this page you can do the following:

Note: After upgrading from PerformanceManager 8.10 to 9.00, the node permissions will not
be carried forward. You need tomanually recreate the node groups permissions from the
OVPMusers.xml.bkp.

Add customer

To add a customer, perform the following tasks:

1. Click Add Customer, theAdd Customerwindow appears.

2. EnterCustomer Name andPassword. Youmust enter the password again in theConfirm
Password text box.

3. Click OK to add orCancel to exit from this window.

Add User

To add a user, perform the following tasks:

1. Select a customer for which you want to add a user.

2. Click Add User. TheAdd Userwindow appears.

3. Enter theUser Name andPassword for the user. Youmust enter the password again in the
Confirm Password text box.

4. Specify the user privileges. The options available are:

n Normal - A user with 'Normal' privileges can draw out-of-the-box graphs. The user can also
design, edit, delete and save graph definitions. The changes are visible only to the user who
logs in to PerformanceManager with the same credentials.

n Read only - A user with "read only" privileges can draw out-of-the-box graphs. The user can
design, and edit graph definitions. The user cannot save any new ormodified graph definitions.

n Display only - A user with "display only" privileges can draw only out-of-the-graph definitions.
The user cannot create, edit, delete or save any of the existing graphs.

Click OK to add orCancel to exit from this window.

If the PerformanceManager is configured with theMicrosoft Active Directory server, you need to
add users to the PerformanceManager. These users must be assigned permission to access the
PerformanceManager configured with theMicrosoft Active Directory server using their valid
credentials.

View or Modify Customer or User Profile

To view a user's profile, perform the following tasks:
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l Select the user whose profile you want to view. Click Profile. TheUser Profilewindow
appears. This window displays the following:

n User Name

n User Privileges

l You canmodify the User Name, change the password andmodify the user privileges.

To view a customer's profile, perform the following tasks:

1. Select the customer whose profile you want to view. Click Profile. TheCustomer Profile
window appears. This window displays the Customer Name.

2. You canmodify the Customer name and the password.

Delete User or Customer

To delete a User or a Customer, perform the following tasks:

1. Select the user or customer which you want to delete. Click Delete Customer/User. A
message asking you to confirm deletion appears. If you delete a customer then all the users
associated with that customer are deleted.

2. Click OK to delete or cancel to exit from this window.

Attach Node Groups

You can attach one or more node groups for a customer. When you attach a node group to a
customer all the sub-groups belonging to the group are automatically attached to the customer. To
attach node groups, perform the following tasks:

1. Select the customer for which you want to attach node groups, Click Attach Node Groups.
TheSelect Groupswindow appears.

2. Click OK to attach the selected node groups orCancel to exit from this window. If you have
selected the top-level group, all sub-groups belonging to the top-level group will automatically
be attached to the customer. When you attach a node group(s) to a customer, the node group
(s) will be attached to all the user(s) attached to the customer. The node groups which you
attached appears in the List of Node Groups configured for this customer. If you have
selected one or more sub-groups, the complete path will be listed.

You cannot select 'All' customers to attach groups. Select one or more groups or sub-groups which
you want to attach.

If you select a top-level group, and then select the sub-group belonging to the top-level group, the
top-level will be unselected. This is because when you select the top-level group all sub-groups are
automatically selected. If you want only a particular sub-group to be attached, you need to select
only the sub-group.
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If you select a sub-level group, and then select the top-level group to which the sub-level group
belongs, the sub-group will be unselected. This is because once the top-level group is selected, all
sub-groups under that are automatically considered for attachment. TheSelect Groups window
displays only the top-level group(s).

Example 1: If customer1 is attached to a group "windows", which contains sub-groups "win2k",
"win2k3" and "win2k8", when customer1 is attached to "windows", all the sub-groups will be
automatically attached. When you select 'customer1', the List of Node Groups configured for
this customer displays only /windows/ and the sub-groups attached to the group "windows" are
automatically considered to be attached to customer1.

Example 2: If customer1 is attached to win2k, which belongs to group "windows". When you
select 'customer1', the List of NodeGroups configured for this customer will display the complete
path /windows/win2k/

View the List of Attached Groups to a Customer

You can view the list of groups or sub-groups attached to a customer. To see the list of groups or
sub-groups, click on the name of the customer. The List of Node Groups configured for this
customer displays the list of groups or sub-groups attached to the customer.

If the customer is attached to a group which has many sub-groups, all the sub-groups will be
automatically attached to the customer. However the list displays only the name of the top-level
group and sub-groups are not displayed.

Example 1: If a customer is attached to a group windows, which has 3 sub-groups, win2k, win2k3
and win2k8, the List of Node Groups configured for this customer displays only /windows/. If a
customer is attached to a sub-group, the list will display the complete path of the sub-group.

Example 2: /Windows/win2k3/ - indicates that the customer is attached only to the sub-group
"win2k3" belonging to the group "windows".

Detach Node Groups

You can detach one or more node groups attached to a customer. To detach node groups, perform
the following tasks:

1. Select the customer from the list of customers. All the node groups attached to the customer
appear in the List of Nodes configured for this customer.

2. Select node group(s) which you want to detach. Click Detach Nodes. A message asking you
to confirm the deletion appears.

3. Click OK to detach orCancel to exit from this window.

The node group(s) you detach does not appear in the List of Nodes configured for this
customer. When you detach one or more node group(s) for a customer, all the user(s) attached to
the customer will automatically be detached from the node group(s).
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Diagnostic View
Diagnostic View of PerformanceManager enables you tomonitor and analyze real- time and near
real-time performance data from the nodes collected by various data sources. It enables you to
draw and design graphs for data available from different data sources. It helps you visualize the
historical and real time data at the same time within the Graphs Panel through separate graphs for
each type of data.

You can also select the time range, for which you want to monitor the data, and drill down to have a
granular view of the available data.

The Diagnostic View consists of two panels:

l Selection Panel - Using the Selection Panel you can connect to data sources, select the
metrics andmetric sub-classes, instances and perform the drill down on any metric class.

l Graphs Panel - You can view the drawn graphs in the Graphs Panel. It helps you perform
advanced diagnostic functions such as monitoring, and comparing performance data for the
selected time period. It also helps you save the customized layout of graphs for future use.

The followingmenus are available on the Diagnostic View page:

l DataSourcesmenu: It gives you options such as Add, Draw, Remove andRemove All .You
can use the options under this menu to add a data source, remove a data source or remove all
connected data sources. You can also redraw a pre-defined graph using theDraw option.

l Graphsmenu: It gives you options such as Tooltips, Navigation Panel, Date Range Panel,
Close All Graphs, Save State, Load State, andDelete State.

l Helpmenu: It displays the online help and tutorials.

Selection Panel
The Selection Panel contains the following:

l Data Sources pane: Displays the nodes you selected from the Connect Data Sources window.
You can right-click in the data sources pane and select Add to add one or more data sources.
The node name appears with the data source in the <systemname::data source> format.

l Metric Classes pane: When you select a data source, theMetrics Classes pane lists the
metric classes available from the data source on the node.

l Instances pane: When you select amulti-instancemetric, the Instances pane lists all the
instances of the selectedmetric class. This pane will not be displayed if a non-multi-instance
metric class is selected.

l Metrics pane: When you select a of metric class, themetrics pane lists themetrics available in
each category.
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The icon is used to refresh a data source. To refresh, select a data source and then click the
refresh icon. When you refresh a data source, all the available metric classes, instances (if any),
and themetrics are refreshed. You can also refresh an RTM data sourcemanually, using this
refresh icon.

Optionally, you can also refresh a data source using the followingmethods:

l Select a data source, click DataSources menu and then select Refresh option.

l Right-click a data source, and then select theRefresh option.

Note: All the available options under the DataSources menu and the right-click options on the
Data Sources pane in the Selection Panel are unavailable until the selected data source is
completely refreshed.

If a communication error occurs while refreshing the selected data source, an error message is
displayed. Click OK to continue. The selected data source is then removed from the list of available
data sources. The graphs drawn for themetrics of the data source are also removed from the
Graphs Panel.

Note: You can show and hide the Selection Panel by clicking on the expand/collapse button
available in the Graphs Panel. You can also adjust the width of the Selection Panel.

Graphs Panel
TheGraphs Panel shows default graph containing important systemmetrics after you connect to
the data source. You can also draw your own graphs using the data available from different data
sources for any selected node.

Connect to Data Sources
You can connect to RTM (Real-TimeMeasurement) and near real-time data sources to graph and
analyze real-time and near real-time performance data from nodes.

To connect to a data source:

1. Click DataSources -> Add. Alternatively, you can also click on the Selection Panel. The
Connect Data Sources dialog box opens.

2. From the node tree on theSelect Nodes pane, you can do the following:
n Select Node or Nodes: Expand the node tree to view the list of nodes. Select the node for

which you want to draw the real-time graph by selecting the check-box adjacent to the node.
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Click to cancel the selection of node. You can also clear the check-box adjacent to the
node to cancel the selection of node

n Search for Nodes

n View System Information

n AddNodes temporarily

n Refresh nodelist: Click to view themost recent changes to the node groups and
nodes.

3. After you select one or more nodes, click List Data Sources. PerformanceManager lists all
the available data sources on the selected nodes. PerformanceManager displays amessage
"No data source found on the selected node(s) if a data source is not available on the node you
selected.

4. If you want to remove a node from the list, click .

5. Click Connect to connect to all data sources in the list.

6. Click Cancel to exit from this window without selecting any data source.

After you connect to the data sources, default graphs appear in theGraphs Panel. To stop
automatic drawing of default graphs, clear theDraw Default Graphs checkbox before you click
Connect.

Remove Data Sources
You can remove a data source that was added previously. To remove a data source, you can do
one of the following:

l Removing fromMenu option
a. From the list of Data Sources on the Selection Panel, select the data source that you want to

remove

b. Click DataSources > Remove.

Note: Click Remove All if you want to remove all the added data sources.

l Removing from Selection Panel
a. Right-click the data source you want to remove and select Remove. Select Remove All to

remove all the added data sources.

A confirmationmessage asking you to confirm removal of data source appears.
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b. Click OK if you want to remove the data source. The data source is removed from the list
and all themetrics associated with that data source are deleted from the graphs inGraphs
Panel.

c. Click Cancel if you do not want to delete the data source.

Note:

l TheRemove andRemove All options are disabled if no data sources are added or if the
data sources pane does not contain any data source.

l When you remove a data source, the graph windows and drill downwindows associated
with themetric class of the data source is removed. The window is removed from the
Control bar menu options.

Launch a Default Graph
You can draw a default graph with pre-definedmetrics for a selected data source.

To launch a default graph for a selected data source, you can do one of the following:

l Drawing a default graph from theMenu option:
a. Select the data source for which you want to launch a default graph.

b. Click DataSources > Draw. The default graph is displayed in the Graphs Panel.

l Drawing a default graph from the Selection Panel:

Right-click the data source for which you want to launch a default graph, and then select Draw.

Alternatively, drag and drop the data source from theData Sources list on the Selection Panel
to the blank space on theGraphs Panel.

The default graph is displayed in the Graphs Panel.

Drawing Real Time and Near Real Time Graphs
You can launch graphs based on real time and near real time data in the Graphs Panel.

To draw a real time and near real time graph:

l Connect to data sources available on nodes. For instructions, see Connecting to Data Sources.
A default graph with pre-definedmetrics is launched in the Graphs Panel.

Note: The pre-defined systemmetrics shown in the default graph window are configurable.
For more information, seeHP PerformanceManager Administrator Guide.
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l Drag and drop ametric from themetrics list on Selection Panel to the blank space on theGraphs
Panel. The graph is drawn in the Graphs Panel for the selectedmetrics. You can drag and drop
any number of metrics. You can also add one or moremetrics to an existing graph in the Graphs
Panel.
n After you draw a graph, you can see the following:

o Legends for themetrics appear on the graph.

o Name of the node from which the data source is collecting data appears in the title bar of
the graph window.

o Themetric name, metric value, and the timestamp of themetric.

Note: However, you cannot drag and dropmetrics from a real-time graph to a historical graph,
and from a historical graph to a real-time graph. The graphs for themetrics will appears in a new
window.

To perform real-time analysis Diagnostic View provides the following options:

Compare metrics from different nodes

To comparemetrics from different nodes:

1. Select ametric class from a node where a data source is available.

2. Drag and drop ametric of the selectedmetric class from theMetrics pane to the graph panel.
Themetric appears in a new graph.

3. Select another node from theData Sources pane on theSelection Panel. The selected node
is highlighted

4. Select the samemetric class and drag and drop the samemetric to the previously drawn graph
on theGraphs Panel.

5. You can now compare the samemetric of different nodes on the drawn graph window.

Compare metrics of different metric classes belonging to the same node

To comparemetrics of different metric classes belonging to the same node:

1. Select ametric class from a node where a data source is available.

2. Drag and drop ametric of the selectedmetric class from theMetrics pane to the graph panel.
Themetric appears in a new graph.

3. Select another metric class belonging to the same node.
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4. Drag and drop another metric of the selectedmetric class to the previously drawn graph on the
Graphs Panel.

5. You can now comparemetrics of different metric classes belonging to the same node on the
drawn graph window.

Note:

l The timestamp displays the time of your browser and not the time at which the data is
collected on the node. There could be a delay of few seconds in displaying the data
depending on your Internet connectivity.

l You cannot drag and dropmetrics from a real-time graph to a historical graph, and from a
historical graph to a real-time graph. The graphs for themetrics will appears in a new
window.

Multiple instances from same data source

To comparemultiple instances of the samemetric in case of multi-instancemetrics:

1. Select amulti-instancemetric class from one node where a data source is available.

2. The Instances pane displays all the instances of themetric class.

3. Select any one instance, by default the first instance in the list is selected.

4. Select themetric which you want to compare and drag it to theGraphs Panel. Themetric
appears in a new graph.

5. Select the other instance which you want to compare with the previously selected instance.

6. Select the samemetric from theMetrics Pane and drag it to the drawn graph on theGraphs
Panel.

Remove metric

Right-click themetric name from the legend and select remove. Themetric is removed from the
graph and will no longer appear in the legend.

Add metric

Drag and drop ametric into an existing graph. The new metric is displayed in the graph and will be
listed in the legend.

Copy metrics from one graph to another

You can drag ametric from one graph and add it to another. The target graph will display themetric.

Note: However, you cannot drag and dropmetrics between real-time and historical graph
windows. Also, if you drag and drop different metrics between two different graph windows, no
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title appears in the target graph window.

Pull out metric from a graph

You can drag ametric from one graph and drop it into the empty space in graph panel area. A new
graph is drawnwith themetric which you selected.

View or Hide Metrics

Click on ametric legend in the graph window. Themetric is disabled and does not appear in the
drawn graph. To view a hiddenmetric, click on the disabledmetric legend.

Change the Metric Label

After a graph is drawn you can change themetric label within a graph. To change the name, right-
click on the label and type the name.

Note: The timestamp displays the time of your browser and not the time at which the data is
collected on the node. There could be a delay of few seconds in displaying the data depending
on your Internet connectivity.

Working With Drawn Graphs
After you draw a graph using real time or near real time data, the Graph Panel displays graph for
each data source as a separate window.

You can perform the following actions on real-time and near real-time graph windows:

Export Performance Data

You can export the data in one of the following formats:

l CSV

l TSV

l XLS

l XML

l PDF

To export performance data:

1. Select Export from theOptionsmenu available on the graph window. TheExport from a
Graphwindow opens.

2. Select the format in which you want to export the data from the list available in the Typemenu
of theExport from a Graphwindow.

3. Click OK.
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Note:

l You need tomodify your browser settings to display data in the XLS and TSV format. See
"Configure Browser Settings to Display Microsoft Excel and TSV Files" on page 7.

l When you export data from real-time graphs, only the data that is displayed in the graph or
drill-down table is exported.

Clone

The clone option enables you to generate a new graph with the same set of metrics (and instances)
of a different data source.

To clone an existing graph:

1. Select Clone from theOptionsmenu in the graph window, TheSelect Datasourceswindow
opens.

2. Select the data source for which you want to clone the graph.

3. Click OK.

By default, the name of the data source appears on the title bar of a graph window.

To change the graph title:

1. Select Change Title from theOptionsmenu available on the graph window. TheChange
Titlewindow opens.

2. Type a title in theNew Title text box.

3. Click OK.

Save as image

To save a graph as an image:

1. Select Save As Image from theOptionsmenu available on the graph window. TheSave in
window opens.

2. Browse to the location where you want to save and type the file namewith which you want to
save the image.

Note: Youmust save the file in the JPG format.

Resize Graph Windows

To resize the graph windows on theGraphs Panel:
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1. Place the cursor at the bottom-right of the graph window and wait till the cursor changes to the

re-size icon .

2. Click and drag themouse to increase or decrease the size of the graph window.

3. Release themouse once the specified graph window size is attained. All other graph windows
in the graphs panel are automatically resized to same size.

Note: If you want to resize a graph window other than the first one, the shadow of the resized
window appears while you drag the bottom right corner of the window. After you finish resizing
the window, all other graph windows are sized similarly.

Rearrange Graph Windows

To rearrange graph windows:

1. Select a graph window you want to rearrange.

2. Drag the selected graph window by the title bar and drop on the graph window of the target
graph window location

3. The selected graph window replaces the target graph window.

Highlight Graph Windows

To highlight graph windows:

1. Click the node from the list in the data source pane. The default graph is highlighted with a thick
blue border.

2. To highlight all graph windows belonging to a particular node, you need to click on the node
from the list in the data source pane. One graph window is highlighted at a time in a round robin
fashion.

View or Hide Metrics

l To disable ametric from appearing on a graph, click themetric legend in the graph window.

l To enable the disabledmetric, click themetric legend in the graph window. The legend is
enabled and themetric appears on the graph

Note:When you disable ametric, the value of themetric does not appear in the graph.
However, for real-time graphs, RTM continues to collect the real time performance data in the
background.
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Maximize or Restore GraphWindows

l Tomaximize a reduced graph window click . The graph window is maximized to the size of
the graphs panel.

l To restore a graph which is maximized, click . The graph is reduced to its initial default size.

Close Graph Windows

To close any graph, click . To close all open graphs windows, select Close All Graphs from the
Graphsmenu.

Drill Down

To drill down to view historical data for a selected period:

l Select Drill down from theOptionsmenu in the near real-time graph window. The Drill Down
Options dialog box opens.

l Select the start date and end date from the Drill DownOptions dialog box and click Draw to view
data for the selected period.

Note: You can drill down and view data as a line graph or table graph. By default, the graph
displays the data for themetrics appearing in the historical graph window. However, you can
also drill down to view data for a single metric class.

Launch Real-Time or Near Real-Time Graphs

To launch a real-time graph from a near real-time graph window:

Select Launch Real Time from theOptionsmenu in the near real-time graph window.

Note: This option will be available only for nodes that have near real-time data. Also, to launch
a real- time graph from a near real-time graph window the same nodemust have a real-time
data source connected to it.

To launch a near real-time graph from a real-time graph window:

Select Launch Near Real Time from theOptionsmenu in the real-time graph window.

Note: This option will be available only for nodes that have real-time data. Also, to launch a
near real- time graph from a real-time graph window the same nodemust have a near real-time
data source connected to it.

Navigate

To select the time period for which you want to view the graph:
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l Select Navigate from theOptionsmenu in the near real-time graph window. The Time Settings
dialog box opens.

l You can select the start date and end date and view the near real-time graph for the selected
period.

Note: This option is available only for near real-time graph windows. The Start Date and the
End Date Time Settings displays the time range dialog box

Navigation Panel

To enable the navigation options in a historical graph window:

Select Navigation Panel from theGraphs menu. The navigation options are enabled in the near real-
time graph windows.

The following options are available in the Navigation Panel:

l Auto Refresh On/Off - You can click on to enable or disable the Auto Refresh option. If
you enable this option, the graph is redrawnwith the latest data available from the data source.
You can use this option to refresh the data in the graph with the recent changes from the data
source. You can configure the data refresh time interval.

l Previous/Next - This option enables you to view the data for the adjacent time intervals, based
on the values specified for the 'points every' while drawing the graph.

l Prepend/Append - This option enables you to view the data for the previous or next set of data
points, in addition to the data you are currently viewing.

Zoom-in and Zoom-out

The Zoom-in and Zoom-out option enables you to adjust the summarization levels in the near real-
time graphs. For more information, see Zoom.

Save the Layout of the Diagnostic View
You can draw multiple graphs in the Graphs Panel with the data available from different data
sources from different nodes.

You can draw composite graphs that aremade of different metrics from different data sources and
customize the layout of the graphs. When you log out or close the browser, all the information
related to the layout of drawn graphs, connected data sources, and the selectedmetrics is lost. You
are then required to reconnect to the data sources to get data and recreate graphs again from the
beginning. To avoid this, you can save the customized layout of the Diagnostic View for future use.
You can, at a later time, retrieve the saved view.

You can also launch the saved layout of the customized Diagnostic View by passing the relevant
parameters in the URL. A URL is generated and displayed in the confirmation dialog box, when you
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save a layout for the Diagnostic View. You can copy this link and launch the saved layout, by
pasting this URL in a browser window.

Note: The URL for launching the saved layout will be shown only for those Performance
Manager users, who do not have any password set for their accounts. Also, this option will not
be available if AD authentication is enabled.

You can save the following in the layout of the Diagnostic View:

l Connected data sources

l Selectedmetric classes andmetric sub-classes

l Graph windows with a set width and height

l Layout view with the Tooltips option enabled or disabled

You cannot save the following in the layout of the Diagnostic View:

l Drill-down table

l Graph windows with specific legends disabled.

To save the layout of the Diagnostic View:

1. Click Graphs > Save State. The Save State dialog box appears.

2. Type a name in the Enter State Name box.

3. Optional. Select theSave the Date range check box to save the state for a particular time
range.

Note: You have to select the date range on the graph before you proceed to save the
layout.

4. Optional. Add a description in theDescription text box.

5. Click Save. The layout is saved by the specified name.

6. A confirmation dialog box opens.

If you logged on to the PerformanceManager console as an administrator or user without a
password, the confirmation dialog box shows a URL that you can use to launch the saved
layout. TheCopy Link to Clipboard button helps you copy the URL to clipboard.

7. Click OK to continue.

When saving a layout, note the following:
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l You can savemultiple layouts in the Diagnostic View by assigning unique names to each layout.

l You can use alphanumeric characters. The only special character you can use is underscore.
The text you type in the text box is not case-sensitive.

l If you assign an already existing namewhile saving a layout, a message appears asking if you
want to replace the existing layout.

To load the layout of the Diagnostic View:

1. Click Graphs > Load State. The Load State dialog box appears if you have savedmore than
one layout.

2. Select a layout from the list.

3. Click Load. The selected layout is displayed.

However, if you are user who does not have any password set for the account you will see an
additional feature to launch a selected layout as following:

1. Select a layout from the list.

2. Click Copy Link to Clipboard button to copy the link.

3. Launch your browser and paste the URL in the address bar.

4. The saved layout is displayed in your browser window. It displays the customized Diagnostic
View for the selected layout.

Note: If you select time range for a graph at the time of saving the state, the layout displayed
will be for that time range only.

To delete the saved layout of the Diagnostic View:

1. Click Graphs > Delete State. The Delete State dialog box appears if you have savedmore
than one layout.

2. Select a layout from the list.

3. Click Delete. The selected layout is deleted.

Note:

l The Load State andDelete State options are disabled if no states are saved.

l You can also launch the saved layout using an URL reference. For more information, see
HP PerformanceManager Administrator Guide
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Date Range Panel
The Diagnostic View enables you to draw and design real-time and near real-time graphs. The
graphs so drawn, displays the available data from the connected nodes depending on values
specified for 'points every', and the default date range of seven days ending 'Now'.

Using theDate Range Panel option, you can perform a detailed diagnosis of the data displayed in
the near-real time graphs. It enables you to customize the graphs to display granular data for the
selected unit of time. You can also drag and drop any metric, and draw a reference graph for the
selected time range. You can use these reference graphs to identify the problem areas and perform
a root cause analysis.

To enable the date range options, click Graphs >Date Range Panel. The Date Range Panel
appears in the Graphs Panel above the graph windows.

The Date Range Panel enables you to do the following:

l Select a unit of time - You can select a unit of time using the drop-down list. You can then view
data for the last hour, day, week or month.

l Select a time frame - To select a time frame, click . The Time Settings dialog box opens.
You can then select the start date and the end date to view the graph for that period. The start
date and the end date values range between the earliest and the latest time stamps available in
the data source.

l Select a time range - You can select the time range from the list. You can then view data for the
specified range such as days in a week, weeks in amonth, andmonths in a year. You can also
adjust the time frame for the selected unit of time. You can also use the navigation buttons to
view data for the selected time frame such as Previous/Next day, week, month and so on.

l Draw a reference graph - You can drag and drop ametric from themetrics list or any of the
historical graph windows to draw a reference graph. You can use this reference graph to perform
root cause analysis.

For example, you can analyze the performance of a web server over a period of time, using the
data collected by SiteScope for the URL response time relatedmetric. You can use this metric
as a symptommetric to identify the various underlying causemetrics. You can look at any of the
system or infrastructuremetrics related to web server collected by the Operations Agent and
SPIs. You can use the URL response timemetric as a referencemetric, and draw graphs for
various system and SPI metrics to analyze the root cause of the problem.

l Apply changes to all the graphs - You can select theAll option to apply the changes made in the
Date Range Panel to all the historical graphs. If All option is not selected, changes apply to the
selected graph only.

l Auto apply changes to all the graphs - If you select theAuto option, changes made in the Date
Range Panel is applied to all the historical graphs. Alternatively, if the Auto option is not
selected, click Apply to update the graphs with the changes made in the Date Range Panel.
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Metric Drill Down
You can use the Drill down option to analyze, comparemetric data and view granular data based on
the selectedmetric class. It enables you to drill down tomultiple levels of the selectedmetric class
to identify the bottlenecks. For example, you can drill down on themetric class Application. Further,
you can drill down on the Application's sub-metric class, Process. You can continue to drill down on
by region and pfile instances of Process.

Sub-classes vary based on the platform agent is running on. For example, on HP-UX, Application's
metric sub-class, Process has Thread as one of the sub-class; however, on Solaris somemetric
sub-classes are not available. For the list of available metric sub-classes, seeHP Performance
Agent's Dictionary of PerformanceMetrics for Sun Solaris. However, you can view themetrics
data for themetric class PROCESS, using the Drill-down option only.

To drill down on a metric class

l For the RTM data source. Right-click themetric class you want to drill down to and select Drill

down You can also select themetric class you want to drill down and click on the Selection
Panel. The Drill Downwindow opens. It displays themetric data in a tabular form. The data
displayed is refreshed at a predefined interval as specified in the RTM data source. See "Drill
DownWindow" below

l For the PA data source. In the graph window, click Options > Drill down. The Drill Down
Options window opens. In this window, select the time range andmetric class, and then click
Draw. The Drill DownWindow opens.

l You can resize the Drill Downwindow by dragging the bottom-right corner of the window. The
mouse pointer changes to an arrow which indicates the direction in which you can resize the
window

l Tominimize the Drill Downwindow, click the . The window appears as amenu option in the
control bar. To restore the window, click on themenu options in the control bar and select the
option to show only theminimized window or all Drill Downwindows which youminimized as
required.

l Tomaximize the window, click the . The drill downwindow is maximized to the size of
browser window. To restore to original size, click .

l To close the window, click .

Drill Down Window
The Drill DownWindow displays the following items:
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l Title of the Drill Downwindow displays the selected node name andmetric class.

l Drill down: Displays the sub classes of themetric class selected and enables you to further
drill down to themetric sub classes.

l New Window: Enables you to open a new Drill Downwindow which displays themetric sub
classes.

l Lock Column: Enables you to lock columns so that they are visible even if you horizontally
scroll to the right side of the window to view the columns on the right hand side. You can also
unlock columns.

l Table Highlights: Enables you to highlight cells based on themetric value specified. For more
information see "Using Table Highlights" on page 85

l Table Filters: Enables you to filter the drill-down table based on themetric value specified. For
more information see "Using Table Filters" on page 86.

l Metrics Table Options: Enables you to add or removemetrics for which you want the data in
the drill-down table.

l Metric Class: Displays themetric class and submetric classes as breadcrumbs. It also allows
you to navigate to the upper level metric class and examine different instances andmetric
classes.

l Save: Enables you to save the data in the drill-down table.

l Update interval: Displays the time interval in which the data is collected by the RTM data
source.

l Last update: Displays the timestamp of the data last collected by the RTM data source.

l Pause: When clicked, stops the data from being refreshed for analysis. The data is not
refreshed after you click Pause until you click Resume.

Note: Any metric related data is not cached during the pause time. You can use the
Standard View of PerformanceManager to retrieve the historical data.

l Resume: The Resume button is enabled only if you click Pause. When you click Resume, the
latest data fetched from RTM is displayed and the corresponding time stamp shows up against
Last Update.

l Help: Displays the help topics.

You can also perform the following tasks from the Drill Downwindow:

Sorting Data

You can sort the data based on any metric appearing in the column. To sort the contents of the
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column, follow these steps:

l Click the column header area of any metric.

l Click on the arrow which appears at multiple column sort area by the side of themetric.

l If you want to sort in ascending order, the arrow should point upwards. By default, when you
select ametric column for sorting, the data is sorted in ascending order.

l The data in the table is sorted based on the selected column and displays the value one at
multiple column sort area of themetric.

l To sort the data in descending order, click on the arrow again. The arrow changes to downward
direction and the data is sorted in descending order.

l You can also select another metric to perform multi-level sorting. When you select the second
metric and click on the arrow which appears at multiple column sort area of themetric, the
selectedmetric column displays a value two at multiple column sort area of themetric.

l To arrange data in ascending or descending order, click the arrow in themetric column tomodify
the direction.

l At any point, you can restart the sorting order by clicking any column. However you need to click
the area of the column other thanmultiple column sort area of themetric header.

Rearranging Columns

You can rearrange a column in the table as required:

Select the column header of themetric which you want to rearrange and drag it and place it at the
required position.

Filtering Drill Down Table Data

You can filter the drill-down table contents based on some criteria to analyze the performance data.

To specify filter criteria, click .The Table Filterwindow appears. For instructions to specify
filter, see Table Filters.

Highlighting Drill Down Table Cells

You can highlight required cells of the drill down table based on certain criteria for easy analysis of
performance data.

To specify highlight criteria, click . The Table Highlightwindow appears. For
instructions to specify highlight, see "Using Table Highlights" on the next page.

Exporting Performance Data

You can export performance data in CSV, TSV, XLS, and XML from the drill-down table.
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To export the data, click . TheExport from a graph window appears. Select from the format
in which you want to export the data from the Type menu and then click OK.

Note: You need tomodify your browser settings to display data in the XLS and TSV format.

Using Metrics Table Options

You can show and hidemetric columns of the drill-downwindow.

You can select themetric columns for which you want to view the data and deselect themetric
columns for which you want to hide the data by using theMetrics Table Options. For instructions to
add and removemetric columns, click Metrics Table Options.

Lock Columns

You can lock one or more columns so that they are always visible when you navigate across
columns using the horizontal scroll bar on the drill-downwindow. You can unlock columns which
are locked.

To lock columns, follow these steps:

l Select the check box Lock Columns. The first column is now locked. You can now navigate
across columns using the horizontal scroll bar in the drill downwindow and the first column is
always visible. The column border after first column appears as a thick line.

l You can add one or more columns to the locked column section. To add another column, drag
and drop any column adjacent to the first column before the thick column border. The column
border indicates the range of columns which are locked.

To unlock columns, follow these steps:

l Deselect the check box Lock Columns.

l To unlock one or more columns, drag and drop the required columns to the area of the table
outside of the thick line. At least one columnwill still remain locked.

Save Drill Down Table

You can save all the changes made to the drill-down table using theSave option.

To save the changes made to the drill-down table, click . A message appears, stating that the
drill down options have been saved successfully. Click OK to save the table.

Using Table Highlights

You can highlight cells by specifying conditions based on themetric value.
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1. Click Table Highlights icon on the drill-downwindow. The Table Highlights window appears.

2. The Table Highlights window displays the following options:
n Themetrics list displays all themetrics of themetric class. By default, the first metric of the

drill-down table is displayed.

n The comparison symbol list displays the comparison symbols to set the condition to the
filter. By default, = sign is displayed.

n The text box allows you to type a value to compare against themetric.

n Click Add to list the given condition below.

n If you want to edit the condition you have just added, make changes and click Update.

n Selected color displays the cell color you chose.

n Click Color to pick any color of your choice which will be used to highlight the table cells of
matching conditions.

n If you want to remove a condition from the list, select the condition and click Remove.

n Click Remove All to remove all the conditions appearing in the list.

n Click OK to filter the data based on the conditions specified in the list.

n Click Cancel to close the Table Highlights window.

n Click Help to display the context-sensitive help topics.

3. Select themetric which you want to highlight based on a condition.

4. Select a comparison symbol. Enter a value to compare against themetric.

5. Click Color, to add a color to the cell. The color picker pop-up appears. Select a color, from the
color palette and click OK.

6. Click OK.

Using Table Filters

To specify the conditions to filter contents based onmetric value:

1. Click the Table Filters icon on the drill-down table. The Table Filterswindow appears.

2. The Table Filterswindow displays the following options:
n Themetrics list displays themetrics displayed in the drill-down table. By default, the first

metric of the drill-down table is displayed.
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n The comparison symbol list displays the comparison symbols to set the condition to the
filter.

n The text field allows you to type a value to compare against themetric.

n Click Add to add to the list of filter conditions.

n If you want to edit the condition you have just added, make changes and click Update.

n Select AND orOR to specify multiple conditions in conjunction.

n If you want to remove a condition from the list, select the condition and click Remove.

n Click Remove All to remove all the conditions appearing in the list.

n Click OK to filter the data based on the conditions specified in the list.

n Click Cancel to close the Table Filters window.

n Click Help to display the context-sensitive help topics.

3. Select themetric for which you want to filter data.

4. Select a comparison symbol and enter a value to compare against themetric.

5. Click Add to list the condition in the Table Filterswindow.

6. Click Update to make changes to the condition added.

7. Select eitherAND orOR to apply multiple conditions.
n AND - filters the rows that satisfy the first condition you set and the row that satisfies the

following condition as well.

n OR - filters the rows that satisfy either the preceding or the following condition.

8. Click OK.

Note:While specifying strings or expressions for filters, use regular expressions. (Example:
.*C.* instead of *C*)

Symbol Description

= Equal

> Greater

< Less

Comparison Symbols
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Symbol Description

>= Greater or Equal

<= Less or Equal

!= Not Equal

!> Not Greater (Same as <=)

!>= Not Greater or Equal (Same as <)

!< Not Less (same as >=)

!<= Not Less or Equal (Same as >)

~ Like (text with leading or trailing ".*" expressions)

!~ Not Like (text with leading or trailing ".*" expressions)

Comparison Symbols, continued

Metrics Table Options

You can show and hidemetric columns of the Drill Downwindow. You can select themetric
columns for which you want to view the data and deselect themetric columns for which you want to
hide the data by using theMetrics option.

To show and hide themetric columns of the Drill Downwindow, click theMetrics option on the Drill
Downwindow.

TheMetric Table Options window appears and displays the following:

l Available Metrics: Displays the list of all themetrics available under themetric class you
selected except themetrics displayed in theMetrics to Display pane.

Note: Available Metrics pane does not display themetrics shown inMetrics to Display
pane.

l Metrics to Display: Displays the list of metrics you want to display in the Drill Downwindow.
By default, it displays a set of pre-definedmetrics available in the drill-down table. You can
select metrics from the Available Metrics pane into theMetrics to Display pane. You can also
movemetrics fromMetrics to Display pane to Available Metrics pane.

l Navigation buttons : Enables you tomove ametric between Available Metrics pane and
Metrics to Display pane.

l Lock the first column: Enables you to lock the first column in the Drill Down table from the
Metrics Table Options window after you update and change the order of metrics in theMetrics to
Display pane. When you select the Lock the first column box in themetrics table options
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window, the Lock Column box in the Drill Downwindow is automatically selected. The first
column in the drill-down table is locked from scrolling horizontally for easy analysis.

l Control buttons : Allows you to rearrange the order of metrics appearing in theMetrics to
Display pane.

Note: This option will be enabled only when there are two or moremetrics in theMetrics to
Display pane.

l OK: If you click OK the changes youmade in theMetrics Table Options window will be
displayed in the Drill Downwindow. TheOK option is disabled if theMetrics to Display list is
empty.

l Cancel: If you click Cancel all the changes youmade in theMetrics Table Options window will
not be reflected in the Drill Downwindow.

Adding Metric Columns

To add ametric to the drill-down table, follow these steps:

1. From the Available Metrics pane, select themetrics you want to display in the drill-down table.

2. Click to add the selectedmetrics to theMetrics to Display pane. The selectedmetrics
does not appear in the Available Metrics pane.

3. Click OK after you complete the selection. The selectedmetrics now appears in the drill-down
table as a column.

4. To cancel the selection, click Cancel.

Locking the First Metric Column

To lock the first metric column in the drill-down table:

l Select Lock the first column box in theMetrics Table Options window. The first metric
name appearing in theMetrics to Display pane will be locked in the Drill Down table.

Note:When you select the Lock the first column box in theMetrics Table Options
window, the Lock Columns box in the Drill Downwindow is automatically selected.

l You can addmore than one column to the locked column section. To add another column, drag
and drop an unlocked column before the thick column border that separates locked and unlocked
columns. The column border indicates the range of columns which are locked.

To unlock the first metric column in the drill-down table:
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l Deselect the Lock the first column box. The thick line after the first column does not
appear.

l To unlock one or more columns and not all columns, drag and drop the required columns to the
area of the table outside of the thick line. The columns within the thick line still remain locked.

Remove Metric Columns

To remove ametric from the drill-down table:

1. From theMetrics to Display pane, select themetrics you want to remove from the drill-down
table. 

2. Click to remove the selectedmetrics from theMetrics to Display pane. Themetric is
moved to the Available Metrics pane from theMetrics to Display pane.

3. Click OK after you complete the selection. Themetric you removed now does not appear in the
drill-down table.

4. To cancel the selection, click Cancel.

Specifying the Order of Metric Columns

1. Select ametric from theMetrics to Display pane which you want to move up or move down.

2. Click to move themetric up or click to move themetrics down from its current
position in the list.

Note: This option will be enabled only when there are two or moremetrics in theMetrics to
display pane.

3. Click OK after you specify the order of metrics. Themetric columns in the drill-down table
appear in the specified order. 

4. To cancel the selection, click Cancel.

Analyzing Metric Class Data
You can drill downmetric classes to analyze and view granular data based on the selectedmetric
class.

Drill down on a metric class and analyze data

Follow these steps:
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1. Right-click themetric class which you want to drill down, for example, Application, and select
Drill down. The Drill Downwindow appears and displays the default metrics for the selected
metric class in a tabular form.

Note:You can launchmore than one Drill Downwindow at the same time. You can add
more than onemetrics of themetric class for which you want to view the data by using the
Metrics Table Options available in the Drill Downwindow.

2. Select an instance from the drill down table showing an abnormal value to further drill down and
identify the bottleneck. For example, other_user_root.

Note: At anytime during the procedure you can select another instance of themetric class
from the window for drill down.

Navigating across Drill Down Windows
You can navigate across different Drill Downwindows associated with different nodes by using the
following:

Control Bar

The control bar appears on the bottom of the Graphs panel as menu when at least one Drill Down
window is open. Name of the node is displayed as amenu, for example, laurel.

To open any of theminimized drill downwindows, click themenu in the control bar. The following
menu options appear:

l Metric class - Name of themetric class for which the drill-downwindow is currently open.

l Show All - Shows all theminimized drill-downwindows for a selected node.

l Hide All - Hides all the opened drill-downwindows for a selected node.

l Close All - Closes all the drill-downwindows for a selected node. After you select this option,
all drill-downwindows corresponding to the data source is closed, themenu options from the
control bar is removed.

Note: If you have selectedmultiple metric classes of different nodes to drill down data, menu
options corresponding to every node name appears in the control bar.

Breadcrumbs

In a Drill Downwindow, breadcrumbs appear next to theMetric Class as hyperlinks. You can easily
navigate to the parent metric class drill-downwindows by clicking the hyperlinks.

If you click themetric or submetric hyperlink, the drill-downwindow is updated to show the parent
metric class information so that you can select a different instance of the parent metric class or drill
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down into another sub class. For example, if you click PROCESS (APP NUM:4) on the thread
(PROC_PROC_ID:10) window the PROCESS (APP NUM:4) data will be updated on the same
drill-downwindow.

PDF version of Online Help
Chapter 2: Getting Started with HP PerformanceManager

HP PerformanceManager (9.20) Page 92 of 93



We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on PDF version of Online Help ( Performance Manager 9.20)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to docfeedback@hp.com.

HP PerformanceManager (9.20) Page 93 of 93

mailto:docfeedback@hp.com?subject=Feedback on PDF version of Online Help ( Performance Manager 9.20)

	Contents
	Chapter 1: Introduction to Performance Manager
	Add Performance Manager to the List of Trusted Sites
	Browser Settings
	Configure Browser Settings to Display Microsoft Excel and TSV Files
	Configure Support for JavaScript
	Install Adobe Flash Player

	Chapter 2: Getting Started with HP Performance Manager
	Standard View
	Drawing Graphs
	Delete Graphs
	Using the Design Wizard
	Designing Graphs
	Designing a Normal Graph
	Designing a System Comparison Graph
	Designing a Instance Comparison Graph
	Designing a Multi-source Graph
	Designing a Forecast Graph
	Designing a Graph for Reporter

	Editing Graphs

	Managing Favorite Graphs
	Overview of Planner
	Types of Forecasting Graphs
	Validating Forecasts

	Related Documentation
	Administrator Tasks
	Manage Nodes
	Manage Users


	Diagnostic View
	Selection Panel
	Graphs Panel
	Connect to Data Sources
	Remove Data Sources

	Launch a Default Graph
	Drawing Real Time and Near Real Time Graphs
	Working With Drawn Graphs
	Save the Layout of the Diagnostic View
	Date Range Panel

	Metric Drill Down
	To drill down on a metric class
	Drill Down Window
	Using Table Highlights
	Using Table Filters
	Metrics Table Options
	Adding Metric Columns
	Locking the First Metric Column
	Remove Metric Columns
	Specifying the Order of Metric Columns


	Analyzing Metric Class Data
	Drill down on a metric class and analyze data

	Navigating across Drill Down Windows



	We appreciate your feedback!



